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Overview



About DVNR The purpose of the DVNR Image Processor toolbox is to carry the instruments of the trade, to be instantly available to the craftsman. The tool shall be like an extension of the user’s will; it must be effective but yet precise. A well-designed, maintained and applied toolbox is a source of power, power that can be transformed to performance, cost efficiency and competitiveness. Designed to solve real problems in real time. The modular approach to the DVNR image processor offers many important advantages. Besides the most obvious advantage is the possibility to tailor the configuration to your requirements, thus avoiding unmotivated financial investments. Another advantage, supported by our upgrade policy, is that you can at any time upgrade the system and take full advantage of the latest technology. Such a policy is more an exception than a rule in our industry, enforced by short product life cycles and high rates of technological development. Digital Vision can demonstrate a user network with fully modern performance from systems purchased in 1989. We have had the same product since then, just a few more upgrades. We are proud to keep your investment.



About Valhall Valhall is a cutting-edge control system for image processing, which moves us to the forefront of the industry. We like to view Valhall as the heart of your work; a complete and comprehensive control system for tape- and disk based image processing. The compact and customised new Valhall offers great economy, in addition to several user-friendly advantages in function and design. The modular system allows you to add on more functionality as your needs change and grow. Valhall is the only control system that accesses the full potential of Digital Vision DVNR Image Processing tools.
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Getting Started



About this manual This manual describes how to operate the DVNR500 and DVNR1000 from the Valhall control system. Operations that can be performed both from the Graphical User Interface (GUI) and from the panels (Premium+ only) will be indicated by the two following symbols: Panels GUI



The Valhall system DVNR (19" x 7RU) VTR (player)



75 Ohm BNC Male-Male



75 Ohm BNC Male-Male



SDI Video



SDI Video



Remote in



VTR (recorder)



Remote in



Remote in



RS422 (9-pin, D-Sub, Male-Male)



Syncro (19" x 1RU) Com1, DVNR Com2, VTR-1 Com3, VTR-2 Com4, Not Used Com5, Not Used Com6, Not Used Com7, Not Used Com8, Not Used



Valhall Controller (19" x 4RU)



RS422 (9-pin, D-Sub, Male-Male) RS422 (9-pin, D-Sub, Male-Male)



SDI Video 75 Ohm BNC Male-Male



Ethernet (UTP, RJ45, Male-Male)



Host, Ethernet Ethernet 2 SD Sync in HD Sync in LTC in



Not Used Not Used Monitor



Loop out



DVNR



Video in



Capture Card Ethernet (UTP, RJ45, Male-Male)



Interconnect cable Interconnect cable



Syncro



Port-1



Panel



Port-2



Spare



Port-3



Spare



Port-4



Ethernet Card 4-port Ethernet (UTP, RJ45, Male-Male)



Local



Port-1



House Network Ethernet Card 1-port



Media
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The Valhall system consists of: Valhall System Controller A 4RU Windows 2000 based platform running the Valhall application with plug-in based software architecture. Valhall-Syncro A 1RU box that connects to the DVNR Image Processing workstation, VTRs and/or DDRs. Valhall-Image An optional control panel for List management and Image Processing included in the Premium+ packages. Valhall-Media An optional editing and machine control panel included in the Premium+ packages. Valhall-Colour An optional dedicated colour grading panel included in the Premium+ Colour package. Read more about installing the Valhall system on page Error! Bookmark not defined..



Panels This section describes some basics on panel operation necessary for the continued reading of this manual. Read more on panel functionality starting from page 113.



Press and Hold Press and Hold means that the key is kept pressed for an extended duration, either to give the key two functions or to prevent accidental activation.



Numerical Entry Numerical entries (event number, timecode etc) are normally done prior to pressing the function key. Both absolute (unsigned) and relative (signed) entries are supported for most operations.



Mode Selection Most keys on the Image panel are assigned for List operation. However, these keys can also be used for Notes, Bookmarks and Stillstore operation. This is determined by the Mode selection keys List, Note, Still and Bookmark.



Modifier keys



Valhall key
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The modifier keys (Valhall, Shift & All) provide additional functionality when used together with other keys. A modifier key is either pressed and released before selecting the second key or held wild pressing the second key. This is normally represented in the manual by key1+key2.
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GUI This section will briefly describe the GUI of the Valhall application.



Toolbar At the top of the workspace a number of buttons are found. They represent the different processing options. Clicking on one of these buttons will open the corresponding window. Tip! If a window for some reason is “off-screen”, it can be positioned in the upper left corner by pressing on the keyboard while clicking on the corresponding button at the top of the workspace.



Status bar On the lowest part of the screen is a status bar, displaying various system settings, error messages etc.



Login The login dialogue (automatically available when starting the Valhall) prompts you to login using your profile. The same dialogue is also used to logout and exit. Read more on page 7



System Setup The system setup determines how your Valhall system is set-up; type of DVNR, number of VTRs/Disks, timing etc. The system setup is accessed from the menu File > System Setup. Read more on page 113



DVNR Setup The DVNR setup is used to configure the DVNR Image Processing workstation. Read more on page 31



Project Manager A project is like a folder containing lists, notes, default settings etc. Projects can be personal or shared with other users. Read more on page …
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User Profile In the User Profile window you can personalise the list behaviour, operation of control panels and more. All settings are stored separately for each User and recalled upon login. Read more on page 33



Notes Notes are used for temporary storage of processing parameters, similar to Presets. Read more on page 25



Bookmarks Bookmarks are used to mark parts in the material on the fly for later attention, typically indicating large pieces of dirt needing special attention after a colour grading pass. Read more on page 23



Machine Control Valhall can control up to 4 VTRs or DDRs. In addition to controlling them from the Media panel in the Premium+ package, they can be controlled from both the GUI and from the keyboard (if mapped in the User Profile dialogue). Read more on page 9



Event List The Event List is used to program processing settings on a scene or a frame basis. Read more on page 11



Timeline Valhall Premium only. The Timeline provides an alternative view to the Event List. It has a look similar to timelines of editing systems. Read more on page 13



Editing Linear editing is supported for up to 4 machines. Edit points can be entered manually or automatically from selections in the list. Read more on page 27
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DVNR Processing Valhall provides the best control of the DVNR Image Processing tools. At the top of the toolbar there is a number of buttons representing the different processing options. Read more on page 31



Video Viewer Valhall Premium only. The re-sizeable Video Viewer provides real-time monitoring of the DVNR output. The video viewer also provides zoom capabilities for regions of interest.



Help System You can for most dialogues call up help by pressing on the keyboard when they are in focus.



Tip! If a window can be opened from a key on one of the control panels, it usually can be closed from the same key by a press and hold operation.



Starting a Project After powering up the Valhall controller (and optional control panels), you can start the Valhall application by double-clicking on the Valhall icon at the desktop or selecting Programs > Digital Vision > Valhall from the start menu.



Login As the Valhall application has started, the Login dialogue window will soon appear.
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Double-click on the User account you want to login as or click and hit return.



Select the proper User account. If you haven’t got one, ask the administrator to create one for you. If the User account has a password, you will have to enter it. Click on the Login button. You are now logged in and the User login window will disappear. The settings/preferences you had when you exited the program last time will now appear again.



Starting a project Open the Project Manager dialogue, click on the Projects tab. Then select Personal or Shared folders to the right in the dialogue. Personal Shared



Select New to start a new project or Open a previously stored project. Note! Only projects previously created with the same user account will be visible. The Administrator can open any project. If starting a new project, enter the name of the project and click on OK when done.



Setting Video Standard Open the DVNR setup window and check that proper input, output, field rate etc. are correctly set before starting the session by clicking on OK. Read more about the DVNR setup on page 45.



Saving Lists Lists can be saved in two different ways 1. Go to the List tab in the Project Manager and choose Save or Save as. 2. From the Image panel, press and hold the Save key. This is a quicksave that do not store thumbnails. In addition an Autosave function is available that will save the current list in the background while working. Autosave can be enabled under the List page in the User Profile dialogue. 8 • Getting Started
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Machine Control



General



Valhall can control up to 4 VTRs or DDRs. In addition to controlling them from the Media panel in the Premium+ package, they can be controlled from both the GUI and from the keyboard (if mapped under Keyboard in the User Profile dialogue). You can define exactly how the Media panels tape transport controls will behave under Media keys in the User Profile dialogue.



Cue to a specific Timecode Enter the timecode on the numerical keypad of the Media panel and then press the Cue key, To e.g. cue the machine 10 frames back, enter –10 and then press the Cue key. In the Cue field of the VTR window, enter the timecode and then press  on the keyboard. To e.g. cue the machine 10 frames back, enter 10 and then press the minus (-) key on the keyboard. Tip! VTR controls can be mapped on keyboard keys F5 – F12 on the Keyboard page of the User Profile dialogue.
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List Management



About the List Management When a change of processing parameters has to be done frame accurately, list management has to be involved. Valhall gives the option to use both a vertical compressed event list and a horizontal timeline (Valhall Premium only) Note! List operations from the control panels (Valhall Premium+ only) can only be performed as long as the List key on the Image panel is lit.



Event list



Event List



You can open or put the timeline on top by pressing the List key on the Image panel. Press and hold to close. If the Event List is selected as the secondary list, you must use the Valhall+List keys. The Time Code Reader display at the top shows the current timecode of the source machine selected as master. The event that is associated with the current timecode will have a blue border.
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An event that has been selected by the user will have a red border (also called a list cursor). Note! Right-clicking on an event in the event list will also recall and execute its parameters. Double-clicking on an event will cue up the connected source machine to the associated timecode. If the event is active on field 2, the machine will be positioned at field 1 one frame later.



The Event information The information given at each event is as follows: Event number The event numbers are automatically rippled as new events are entered. Timecode The timecode associated with the event. Field 2 is indicated with an asterisk (*). Scene Scene/cuts are indicated with a pair of scissors. This is done automatically when the autoshot detector creates a new event. Field-dominance. Indicates the field dominance (F1/F2) in 50Hz/25fps or 60Hz/30fps film originated material. In 60Hz/24fps film originated material, the field in the 3:2 pull-down sequence is displayed as A1, A2, B1, B2, B3… Film/Video A film frame indicates film originated material, while the diagonal stripes indicate video originated material. A film frame with a diagonal cut tells you that that the 3:2 is discontinued. Comment: Shows the text entered after pressing F2 on the keyboard. Events can be found, in the Search menu, by their comments. Tip! To change the list layout and amount of information shown, go to the List layout page in the User Profile.
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The Event indicator



The Event indicator lets you know for each process list whether an event is programmed or not, if an option is in bypass, if a key area is used etc. The following indicators are used: None



No parameters programmed



Grey



Parameters programmed



Red



Bypass



White fill



Key area used



In addition, some indicators may appear dimmed to let you know that the settings are identical to the ones in the previous event. This feature can be enabled by checking the Shadow Identical Settings control under the List layout page in the User Profile dialogue.



Time Line



Timeline



You can open or put the timeline on top by pressing Valhall+List on the Image panel. Press and hold to close. If the Timeline is selected as the primary list, use the List key only. The blue line indicates the position of the source machine while the red line represents the list cursor. Note! Clicking somewhere in the timeline will cue the source machine to the same location.
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Tip! To change the list layout and amount of information shown, go to the List layout page in the User Profile.



Building a List The starting point for a tape-to-tape job is to build a decision list consisting of separate sections with different processing parameters. For colour correction, the list typically consists of events located at the scene-changes or cuts. When building the list either an edit decision list or the built in scenechange detector can be used to automatically generate events.



Building a list using Autoshot •



Select New in the List tab of the Project Manager.



•



Rewind the source tape to the start of the program to process.



•



Enable Autoshot.



Autoshot will build a list consisting of blank events with no parameters programmed. When parameters are changed the changes in the present event will be the starting point in the successive event. E.g. the change will be “carried over” to next events. •



When the tape has played through the whole program, rewind the tape.



Tip! In the User Profile, Autoshot can be made to automatically turn off in order not to create any false events when the tape is played back before the last event. This function is called Autoshot – Disable inside list •



Make sure that Set On Exit is enabled when you begin grading. In that way the operator does not need to store the parameters manually when going from one event to the next.



Building a list using an Edit Decision List •



Select Import EDL in the List menu.



•



Select the EDL file and hit enter. If another extension is used than EDL, type *.* in the File Name edit box.



A list of non-programmed events will be generated. The events will be located at the recorder in-points where straight cuts (including video) have been made. At the operator’s preference, the settings from the first event and onward can be changed. Each change/parameter set-up that is stored will be the one used in the next event as well. If each event shall have the same starting point, e.g. zero settings in the colour correction, then: 14 • List Management
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Set-up the control parameters and colour grading you want the whole list to use as default.



•



Select all events by choosing All+Select.



•



Press the Enter key. All events will be programmed with the same parameters as the first event.



Now all events have the same basic settings and the operator can start grading.



Working with the List General The operator plays the source VTR and monitors the picture on the video monitor. If colour correction is to be performed, a list consisting of all scene changes/cuts has probably been made using one of the two methods described in the previous sections. If only noise reduction, scratch/dirt removal and/or other image enhancement processing are used, a pre-generated list is not necessary. The operator will only mark events where the processing needs to be optimised. Neither does the operator have to pre-build the list for colour correction. Autoshot can be enabled at all times as it only generates events when the tape is running. That way the operator can run the VTR, stop after a scene-change, apply grading, and play further until the next scene-change. The only drawback is the ability to move quickly from scene to scene, only spending the necessary time to make the colour correction. A list with all scene-changes marked is then necessary to be able to cue up between scenes.



Programming events The easiest way to program or update the decision list is to use Set On Exit (found in the User Profile dialogue under List) as no confirmation is needed for changes. The changes are stored when the VTR is played into next or previous event. To avoid an update of the event, a “Recall event” must be done before entering the next event. To manually program an event, press the Enter key on the Image panel. If “Set changes only” is enabled in the User Profile dialogue, only the changes will be programmed. To force all settings to be programmed, press All+Enter.
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Recalling settings Position the list cursor on the event to recall and press the Recall key on the Image panel. To recall e.g. event number 100, enter 100 on the numerical keypad and press Recall. To recall an event located 4 events back, type -4 and then press Recall. Settings can also be recalled while browsing the list using the up/down arrows by simultaneously keeping the Valhall button pressed. Right-click in the information field to the left in the Event List to recall settings. By right-clicking in a specific processing list, only the corresponding settings will be recalled.



Inserting an Event To insert a new event at the current source machine position, press the Mark key on the Image panel. Alternatively enter the timecode on the Media panel and then press the Mark key. In addition, when keeping the Mark key pressed, the current settings are also programmed.



Inserting one-frame Events Sometimes it is necessary to create one-frame events e.g. for scratch removal with a key area. Place the source machine at the frame where the one-frame event is to be created. Ensure the settings you want to program are correct. Press the Frame key on the Image panel. A new event is created at the current position programmed with the current settings. Unless an event already exists, there will be one programmed one frame later with processing parameters restored. Tip! To preview the effects of the stored settings, press the Valhall key followed by the Frame key on the Image panel. The machine will start playback three seconds before the one-frame event and return to the original position three seconds after passing the event.



Updating Thumbnails To manually update a thumbnail press and hold the Enter key on the Image panel.



Working with Selections Normally list operations are applied to the event where the list cursor is placed. To apply an operation to more than one event “Selections” can be made.



16 • List Management



User's Manual



Once one or more selections have been done, operations are applied to these and not the event where the list cursor is placed. In order to apply a series of operations to the same selected events, these remain selected until manually unselected.



Selecting an Event Position the list cursor at the event to be selected and press the Select key To unselect, press an hold the Select key Keep the Ctrl key on the keyboard pressed while clicking on an event to toggle selection



Selecting a range of Events Place the list cursor at the first event in, press the Shift key and keep it pressed while pressing the Up or Down key. Place the cursor at the first event in, press the Shift key on the keyboard and keep it depressed while pressing the Up or Down key.



Selecting an Event by number An event can also be selected by its number, by entering the Event no. on the Media panel and pressing the Select key on the Image panel. To e.g. select an event 3 events later (of the list cursor), enter +3 and press the Select key Same operation applies to unselect but with the difference that one have to press and hold the Select key.



Selecting a range of Events by number You can also specify a range of events by number by using the “,” key. Examples: 150,200



Select Events 150 through 200



,150



Selects all Events up to 150



200,



Selects all Events from 200 and forward



-10,+10



Selects 10 events before and after the list cursor



Same operation applies to unselect but with the difference that one have to press and hold the Select key.



Unselecting All First press the All key and then press and hold the Select key.



User's Manual



List Management • 17



Comments Adding a Comment Ensure List mode is selected and that the list cursor is at the proper position in the event list, press on the keyboard, enter text and press return. In the Event list, right-click in the comment field to the right, wait for cursor, enter text and press return.



Searching for a Comment To find an event based on a comment, select Edit > Find comment… in the Event List. Enter the word to search for. If a comment matches your search criteria, the list cursor is automatically placed at that event. Press to find next event to meet your search criteria.



Search and Select To select all events matching your search criteria, enable Find and select all. The list cursor will be placed at the first selected event. Note! Selections made prior to the “Find and select all” operation will be lost.



Using Dynamics



Two consecutive dynamics



Overlapping dynamics



A dynamic is a transition in time between two sets of parameters, typically colour gradings or pan-and-scan.
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1



2



3



4



time Figure 1: Sequence in Decision list without dynamics 1



2



3



4



time Figure 2: Same sequence in Decision list but with dynamics



The following is an example of how a dynamic can be programmed in the list (figure 2 above shows the changes of a parameter e.g. gamma): 1. This event is a normal cut, parameters stored with Set. 2. This is the In- or start-point of the 1st dynamic. Unless the dynamic should start with other parameters than the previous event, ensure that both the previous event and the start of the dynamic contain the same settings every time one of them is changed. 3. Out-point of the 1st dynamic. Parameters stored with Set Dynamic. This event will automatically become the in-point of next dynamic (if any). 4. Out-point of 2nd Dynamic. Define your In- and out-point with two programmed events. On the second, press the Dyn key on the Image panel. To remove a dynamic, press and hold the Dyn Key.



Timecode Trim If one or more events are not correctly aligned to e.g. cuts, a trim of the event timecode can be done. First select the event(s) to be trimmed, enter the trim offset (+/-) in hh:mm:ss:ff from the Media panel and then press the Trim key on the Image panel.



Correcting mistakes (Undo) List operations can be undone of you make a mistake. Due to memory limits up to 5000 levels of undo is available. To undo the last list operation, press the Undo key on the Image panel. To redo the last operation, press the Redo key.
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To undo the last list operation, select Undo from the Edit menu of the Event list window. To redo the last operation, select Edit > Redo.



History window



The History window allows you to jump to any recent state of the list (within the limit of undo levels) during the session. The latest list operation is found at the top of the window. Click on an event in the history window to undo all entries done after this (events above in the list). To open the History window from the Image panel, press Valhall+Undo. To close, keep Valhall+Undo pressed.



Working with individual Processing Lists Single



If you want to work e.g. with just colour grading and deal with the rest of the processing at a later point you can use the Single function. This inhibits the programming of everything but the selected processing option. First select the processing option from the menu selection on the Image panel and the press the Single key. Note! As soon as any option is locked or unlocked using the Lock function as described below, the Single function is disabled.



Lock



20 • List Management



User's Manual



On or several processing lists can be locked to prevent accidental programming. First select the processing option from the menu selection on the Image panel and the press the Lock key. Note! When using the Recall key from the Image panel, only settings not locked will be recalled. To recall all settings, use All+Recall.



Hold



When enabled, parameter settings for the selected processing option are not updated by the list. It’s a sort of a bypass of the list. First select the processing option from the menu selection on the Image panel and press the Hold key. Press All+Hold on the Image panel to hold all options.



Bypass List Programmable on one of the function keys, this control “bypasses” the whole list and does not affect any Hold as described above when disabled.



Importing/Exporting EDL File Menu (Importing/Exporting EDL) Import EDL Imports an EDL-list from floppy or hard disk where the in-points on the recorder are used to create the Processing Decision List (PDL) events. The EDL import handles different Sony and CMX formats. For availability of other formats, please contact your distributor. Export EDL Exports an EDL list with in- and out-points according to the PDL list. Once the filename of the EDL list is determined, an EDL Export dialogue appears. The EDL Export dialogue allows a number of different EDL formats (CMX3600, CMX3400A, CMX3400, CMX340, Grass Valley) to be selected. Note! Since the PDL does not have out-points, the last out-point in the EDL is by default set to 1 minute after the in-point.
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5.



Bookmarks



General



Bookmarks are used to mark parts in the material on the fly for later attention. Typically a bookmark could indicate a large piece of dirt needing special attention after a colour grading pass. Bookmarks are indicated in the Timeline. In addition, the Bookmarks window presents all the bookmarks in a list together with corresponding timecodes. To identify certain bookmarks, comments can be added. The Bookmarks window is opened by pressing Valhall+Bookmark keys on the Image panel. First press the Valhall key, the press and hold Bookmark to close.
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Operation Inserting Bookmarks Quickly press the Bookmark key on the Image panel to insert a new bookmark.



Browsing Bookmarks To go to a specific Bookmark, enter the associated number followed by the Bookmark key. To go to next or previous bookmark, press “+” or ““ followed by the Bookmark key. To e.g. go three bookmarks forward, enter “+3” followed by the Bookmark key.



Deleting Bookmarks Ensure the Bookmark key is selected, and then either position the list cursor at the specific event with the up/down keys or enter the bookmark number from the numerical keypad and then press the Delete key on the Image panel. To delete all bookmarks, press All+Delete. Right-click on the bookmark and select delete from the pop-up menu.
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6.



Notes



General



List view



Thumbnail view



Notes are used for temporary storage of processing parameters, similar to Presets. Valhall provides three sets of notes: Project – Notes stored on a project basis Personal – Notes available upon login Shared – Notes accessible by every user, but only writable with special permission Valhall Premium also provides a thumbnail view of the notes, which makes it easier to remember notes without the need for a comment. List or thumbnail view can be selected in the view menu.
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Operation To switch between the different sets of notes, press Valhall+Note on the Image panel. Without using the Notes window Enter the notes number from the numerical keypad on the Media panel, press and hold the Note key on the Image panel to store, press shortly to recall. Using the Notes window First press the Note key, use the wipe wheel or up/down arrows to position the cursor. Press Enter to store a note, Recall to recall a note and Delete to delete a note. Right-click on a note and a pop-up menu will appear, from which enter, recall or deletion of the selected note can be done.



Adding a Comment Ensure Note key is selected, with up/down arrows or wipe wheel, go the note, press on the keyboard, enter text and press return Click at the bottom field of the note (in thumbnail view) or in the right field of the note (in text view), wait for cursor, enter text and press return



Quick-Notes Quick-Notes are similar to the regular Notes, the difference being that they only can be accessed when programmed on function keys and that they store and recall the settings for the currently selected processing option. Quick-Notes are only stored on a project basis. Tip! If you want to have Quick-notes on the Colour panel that do not change as other Quick-notes depending on the selected option, there are dedicated Colour Correction Quick-notes for this purpose. These programmable functions are found in the DVNR ACP group and are called Mem 1-6.
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7.



Editing



General Valhall supports up to four machine VTR/Disk based linear editing using P2 (Sony) control.



Getting started First, make sure that both machines are set to Remote control and properly connected to the Valhall-Syncro using standard RS422 cables. The Player (VTR1) should be connected to RS422 connector 2 of the Syncro and the Recorder (VTR2) to RS422 connector 3. Note! The machines must support the Auto Edit function as found in the Sony VTR Protocol.



Pre-striping a tape Set up the Recorder with a tape, and the correct machine settings; TC Internal gen. TC Preset source etc. Press Edit on the Valhall toolbar. Unlock lock checkbox next to the Rec button on the Recorder column dialogue located in the Edit dialogue. Press on Rec to begin a crashrecording with timecode generated from 00:00:00:00. For a different start timecode, set any valid timecode as “IN” for the device and click REC.



Ganging Occasionally the starting point of the recorder may not be the same as on the player. In this case, a relationship has to be set up between the machines.
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Select VTR 1 (typically) and enter the reference point of the player, press the Valhall key followed by the In key. Select VTR 2 (typically) and enter the reference point of the recorder, press the Valhall key followed by the In key. Either manually enter the reference timecode in the Ref boxes of the Edit dialogue, or press the Ref button, when the VTR is located at the reference point. Ganging information is stored and recalled in the project.



Editing Selecting the Edit Mode Two editing modes are supported: Assemble mode and Insert mode.



Assemble Mode New scenes are added to the end of existing recorded scenes. Video, audio channels and time codes are recorded at the same time. Click in the Assemble check box to edit in Assemble mode. Note! In Assemble mode, recording continues for a certain distance beyond the edit out point, in order to record control information for the next segment. This means that pre-recorded information beyond the edit Out point will be erased. Please use the Insert mode if you wish to insert material onto a pre-recorded tape.



Insert Mode A segment of new material is inserted onto the tape between two predetermined points. Video, audio channels and time code can be recorded separately or at the same time. Select one or more of the Insert boxes – Video, A1 (Audio channel 1), A2 (Audio channel 2), TC (Time Code) – to select the input signals. Note! In insert mode editing the recording tape must contain uninterrupted control information.



Setting Edit Points 1. Select the Player from the Media panel by pressing the ‘VTR 1’ key. 2. To set the In point, either a) using the search dial, place the tape at the in point of the source material and press the ‘In’ key or b) type in the timecode from the numerical keypad and press the ‘In’ key. 3. To set the Out point, either a) using the search dial, place the tape at the out point and press the ‘Out’ key
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or b) type in the timecode from the numerical keypad and press the ‘Out’ key. 4. Select the Recorder from the Media panel by pressing the ‘VTR 2’ key. 5. Using the tape transport keys, search dial or manual entry of time code (as in 2.), place the Recorder on the in point.



Executing the Edit When all of the edit points are set correctly, you can now execute the edit by pressing the Edit button.



Stopping the Edit To stop the edit before the Out point is reached, press the Stop key.



Edits based on List selections. Quick editing can be performed based on list selections. The last event cannot be selected since Valhall considers this an open event. For better control of the operations open the Event dialogue by clicking the Edit button on the Valhall Toolbar or pressing Valhall+Edit on the Media panel. Make sure that the VTRs you want to use in the edit have correct Ref points set (can be found in the Edit dialogue). Two mirrored timecoded tapes should have their corresponding Ref set to 00:00:00:00. Press and hold Edit. The selected events will now be imported and edited.



Intelligent Editing The Edit mechanism automatically minimizes the total time needed for a number of consecutive edits. If the time in between two edits is short, the Intelligent Editing will switch off the recording between the two events and switch on at the in-point of next event. If the time between two edits is long, the machine will cue up to next event and perform a preroll.



Trimming Edit Delay and Offset. Edit Delay 1. Open the Edit dialogue 2. Ensure the Reference points are the same on the player and recorder 3. Ensure Rec Inhibit is off on the recorder and that the tape is not write-protected
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4. Set the Recorder to ”Regen/Internal ”and ”VITC On ” on the VTR 5. Set Insert video on the Recorder in the Edit dialogue 6. Create an event in the list, with a duration of a couple of seconds 7. In the list, select the event to edit 8. Click on the Test Button on the Valhall Toolbar, select a recognisable pattern different from the one found on the tape 9. Select menu File > Edit in the Edit dialogue 10. After editing, verify the actual in- and out-points of the edit on the recorder 11. Trim the Edit delay in the System Setup for the recorder (positive if the edit is late and negative if early) and repeat steps 8 to 10 until the edit performs correctly



Offset 1. Open the Edit dialogue 2. Ensure the edit delay as described above is correct for the recorder 3. Ensure the Reference points are the same on the player and recorder 4. Ensure Rec Inhibit is off on the recorder and that the tape is not write-protected 5. Set the Recorder to ”Regen/Internal ”and ”VITC On ” on the VTR 6. Set Insert video on the Recorder in the Edit dialogue 7. Enable ganging 8. Set in-point for the player one frame ahead of a scene change 9. Set duration of the edit to approx 1 second 10. Select menu File > Edit in the Edit dialogue 11. After editing, verify that the scene change is one frame after the actual in-point on the recorder 12. Trim the Offset in the System Setup for the recorder (positive if the scene change is inserted late and negative if early) and repeat steps 10 and 11 until the edit performs correctly
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8.



User Management



General Administrator The Administrator can add new users and grant access to e.g. user management and system setup. At delivery, no password is set for the Administrator. Access rights are not inherited.



Administration Adding new Users Go to menu User > Management Click on the Add button and then enter the new user name and select the user, which the new should be based on (inherits the User Profile settings) in the dialogue that pops up. Note that access rights are not inherited. If you want to change these settings, click on the Properties button. Tip! Add a user (e.g. “default user”) as a template on which all new users can be based.
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.
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9.



User Profile



General In the User Profile window you can personalise the operation of control panels and more. To get to this window, click on the User Profile button at the top of the workspace. Settings are automatically stored upon logout



List



The List section determines the operation of the list. Align events to film frames When enabled, manually entered events are automatically aligned to film frames.
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Force field 2 cue up This control should be enabled for machines that are not capable of cue up to field 2. Disable scroll lock Normally the event list and the timeline are locked together, when scrolling from the wipe wheel or the up and down keys on the Image panel. By checking this control, the wipe wheel only scrolls the timeline and the arrow keys only scroll the event list. Assign Wipe wheel to event list When in List mode, the wipe wheel is normally used to browse in the time line. By Autosave The Autosave feature automatically makes a background save of the list when enabled. Note that Autosave does not store thumbnails. To store both the list and the thumbnails, go to the List page of the Project Manager and choose Save or Save As.



Set operation Set changes only Normally all settings are programmed at each event. By enabling “Set changes only”, only the settings that have been changed will be programmed. Set on exit Using “Set on exit” there is no need to enter settings manually for the events. As soon as the source machine passes an event boundary the current settings are automatically stored in the previous event. Store thumbnail When enabled, automatically updates the thumbnail.



Autoshot Enable Autoshot automatically registers cuts/scene changes as the source machine is in playspeed. Autoshot On/Off can be programmed on one of the programmable function keys. Disable inside list When enabled, autoshot automatically turns off in order not to create any unwanted events when the tape is played back before the last event. Filter To prevent false autoshots filling up the list you can set the minimum interval that has to pass after an autoshot has created an event, before it creates the next one.
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Select as Primary List Valhall Premium+ only. The List button on the Image panel is used to open the primary list window (the list which you use the most) while Valhall+List is used to open the secondary window.



List Layout



The List layout page determines how the Event List and the Timeline (Valhall Premium only) will appear.



Event list View Thumbnail Valhall Premium only If enabled, displays a thumbnail of one of the first frames of the event, captured by the autoshot. View Info Shows the information field (including timecode, event no etc) when enabled. View Process lists When enabled, the process lists containing information on when settings and dynamics has been programmed, is removed.
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Single line Rearranges the layout of the information field to reduce the height of the event. Only makes an effect when thumbnail size has been set to small. Shadow Identical Settings



When enabled, indicates parameters in programmed events that are identical to the previous event with dimmed arrows.



Timeline Valhall Premium only. View Thumbnail If enabled, displays a thumbnail of one of the first frames of the event, captured by the autoshot. View Info Removes the information field (including timecodes, bookmarks etc) between the thumbnail and process lists when enabled. View Process lists When enabled, the process lists containing information on when settings and dynamics has been programmed, is removed.



Thumbnail display Source Set the picture source format. Aspect To display the correct aspect, set to 4:3 except for anamorphic (16:9) sources. Size Determines the displayed thumbnail size in the lists.
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VTR



The VTR tab sets up some behaviour for the VTR controls.



Configuration Show window when VTR is selected When selecting a VTR from the Media panel, the corresponding window will pop up if this control is enabled. Disable change of Jog/Shuttle from dial When enabled, jog/shuttle mode cannot be changed by pushing the dial, only the Jog key will change mode. Disable Jog control in normal play If enabled, this control prevents the VTR stopping, if the search dial is accidentally touched, during normal play. To jog or shuttle, first press the Stop key.



Acceleration Jog Sets the sensitivity of the VTR search dial when in Jog mode. Shuttle Sets the sensitivity of the VTR search dial when in Shuttle mode.
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Keyboard



Function keys F5 through F12 in combination with shift or ctrl can be programmed to perform various operations. Swaps programmed function. Makes selected function key non-programmed.
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Panel



These controls affect the operation of the control panels (Colour, Image, Media). Only applicable for Valhall Premium+. Enable trackball lights If checked, enables the trackball backlight on both Colour and Image control panels.



Brightness Display Sets the brightness/intensity of the displays to match room conditions. Indicators (LEDs) Sets the brightness/intensity of the key LEDs that are lit to show that the function is activated.



Press and Hold Delay Sets the minimum amount of time in order to active the “delayed” (press and hold) function of knobs and buttons. Repeat rate Determines how fast commands are repeated when e.g. up and down keys are kept pressed.
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Window Control Show when menu is selected When selected, process window will appear when selected from the option selection menu on the Image panel. Hide when menu is unselected If this item is selected, the previously displayed process window is hidden when a new is selected from the option selection. Select page when accessed from panel When selecting a page on the colour or image panel, corresponding page on the processing window in the GUI will be selected if this control is enabled. Select panel menu on window select When a processing window is put in focus in the GUI, the corresponding processing menu is selected on the panels. Select panel page on GUI changed When selecting a page in the GUI, corresponding page on the top displays of the panels is selected.



Media Keys



Only applicable for Valhall Premium+. The transport control keys are user programmable to match your specific requirements. In addition, the Valhall key increases the number
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of controls by providing a second set of programmable transport controls. First select a group of functions and then select the specific function. Functions can be programmed for both Press as well as Press and Hold operations. Swaps programmed function. Makes selected function key non-programmed.



Image Keys



Only applicable for Valhall Premium+. Pre-defined functions can be mapped to the programmable function keys. Modifier keys Valhall and Shift can be used to access another three sets of functions. Labels F1-F4 and M1-M4 does not restrict the key usage to functions and memories. First select a group of functions and then select the specific function. Functions can be programmed for both Press as well as Press and Hold operations. Swaps programmed function. Makes selected function key non-programmed.
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Colour Keys



Only applicable for Valhall Premium+ Colour. The Colour panel provides a large number of programmable function keys within easy reach from the trackballs. They can be programmed individually for each user to perform various operations including memories, machine and list control. First select a group of functions and then select the specific function. Functions can be programmed for both Press as well as Press and Hold operations. Swaps programmed functions. Makes selected function key non-programmed.



42 • User Profile



User's Manual



Sound events



Here you can attach a sound to a specific event like Autoshot, prompts etc. Only applicable if speakers are connected.



Adding sounds Own sound files in .wav format can be added in the directory c:\program files\Digital Vision\Valhall\sound files\
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10. DVNR Setup



General The following is a detailed description of the DVNR Setup window and its controls: Please check that proper input, output, field rate etc. is set correctly before starting the work by clicking on OK. The DVNR Setup window may look slightly different depending on which image processing device is controlled. Note! DVNR Setup settings with the exception of origin and field dominance are stored on a project basis and are not programmable in the list.
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DVNR1000-422 Media



Origin Select if input is Film (frame based) or Video (field based) originated. Important for internal processing as e.g. ASC. Field dominance Select 1st or 2nd field dominance depending on the input. This is mainly applicable to 50 Hz processing of film based original. Note! Both origin and field dominance can be changed in the list on an event basis.



Video



Fieldrate Selects input field rate e.g. 50, 60 Hz
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Input Select input format Ext Genlock The DVNR normally locks the output to the incoming video signal. If Genlock is enabled, the Frame Store Synchroniser locks to the B&B signal fed to the Genlock input. 8-bit The input is normally 10 bit, but can be set to 8 bit with this control.



Output Select output format. Note that this also affects the delay through the system (See “Delay” in this section). Mono When enabled, sets video output to monochrome. 8-bit The output is normally 10 bit, but can be set to 8 bit with this control. Black clip Enables black hard clip at level 64 (0%). White clip Enables white hard clip at level 940 (100%). Chroma clip Enables chrominance hard clip at level 960.



RGB Limit Limits to legal RGB. Can be set for low- and/or highlights. If neither checkboxes are set, no RGB limitation will occur. Note!



RGB limitation is only available with ACP



Delay
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This feature enables the user to re-time the total delay from the selected input to the selected output of the system by approx. +/- 2 lines in steps of 1 pixel. The "Output delay" is stored separately for each "Input", "Output" and "Genlock" setting. Right-click on a slider to set default values. Press Clear to return to factory defaults or Store to store any changes you have done. Y+C Adjusts the total delay through the system C Adjusts the chroma delay only



DVNR1000-HD Media



Origin Select if input is Film or Video originated. Important for internal processing as e.g. ASC. Field dominance Select 1st or 2nd field dominance depending on the input. This is mainly applicable to 50 Hz processing of film based original.
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Video Input



Input Format Sets the line format on the input. 8-bit The input is normally 10 bit, but can be set to 8 bit with this control.



Input Fieldrate Sets the input frequency.



Sync source Auto



N/A



External Ref.



Locks the Frame Store Synchroniser to the B&B signal fed to the Genlock input.



Input



Locks the Frame Store Synchroniser to the input signal



Internal



Locks to internal oscillator on the input board. No external signal at all needed.



Video Gain Separately controls luminance and chrominance gain with a range of 0% to 200% of the input signal. Right-click on a slider to set default values.
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Video Output



Format For some input configurations it is possible to do a conversion to another format. In this case, you will be able to select an output format. When set to Auto, the output format is identical to the selected input format.



Clip Black clip Enables black hard clip at level 64 (0%). White clip Enables white hard clip at level 940 (100%). Chroma clip Enables chrominance hard clip at level 960.



Output 8-bit The output is normally 10 bit, but can be set to 8 bit with this control. Mono When enabled, sets video output to monochrome.
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Setup



Scene Change Detector Sensitivity Adjust sensitivity until the Scene Detector picks up all scene changes. Threshold By increasing the Threshold value, the amount of false detections may be reduced. Note! Setting this value too high may cause real scene changes not to be detected.



Film 3:2 The 3:2 detector need to have the below thresholds fulfilled in order to detect a change in the 3:2 phase. Threshold max value This threshold is used for detecting the repeated field. In an ideal situation the 5th field in a 3:2 sequence should be an identical copy of the 3rd field. However, by setting the Threshold max value higher, analogue tape noise and other errors are ignored. Default value is 1. Repeated fields may not be detected at all if the threshold is set to 0. Threshold min value This threshold is used for detecting motion. High values are used for picture material with much motion. Low values are used for picture material with little motion. Default value is 8.
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Delay



This feature enables the user to re-time the total delay from the selected input to the selected output of the system by approx. +/- 2 lines in steps of 1 pixel (74 ns). The "Output delay" is stored separately for each "Input", "Output" and "Genlock" setting. Right-click on a slider to set default values. Press Clear to return to factory defaults or Store to store any changes you have done. Y+C Adjusts the total delay through the system C Adjusts the chroma delay only
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11. DVNR Processing



General Operation Bypass Each processing option is equipped with an electronic Bypass. It can be accessed in on of the following ways: Pressing the Byp key on the Colour or Media panel or alternatively pressing the Valhall key and the corresponding option selection key on the Image panel. Double-clicking on the menu bar or selecting Bypass from the control menu. Bypass is indicated with [Bypass] after the option name in the menu bar. Note! Unlike some other systems, the bypass function does not affect the video delay through the DVNR.



Bypass All A bypass of all processing options can be done using the Bypass All key on the Image panel.
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12. ALS, Anti-Aliasing



About the Anti-Aliasing The ALS is an indispensable tool when there is need to improve negative side effects from out-of-band vertical frequencies, showing up as undesired line flicker or “twitter”. Treats scenes with venetian blinds or car grills appearing in their best light, as sharp as the line structure in the interlaced television system will allow. With two filters and fine user controls in 256 steps the ALS will handle both field (video) and frame (film) based source material in an optimum way. In addition ALS features a special field correlator mode enabling “film look” on video originated material.



Controls



Anti-Aliasing window
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Filter Type Sharp



Sharp cut-off (Recommended setting)



X Sharp



Very Sharp cut-off



FieldCorr



You can say that the Field Correlator removes a field and recreates it by interpolating the remaining field. I.e. simulating film look. It has little effect on film based material, but dramatically reduces the resolution on video-based material containing motion. Suitable for MPEG1 compression and when using a high compression ratio.
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Cutoff The cutoff controls the amount of filtering and selects how much, in percent, of the maximum vertical bandwidth that is kept. 100% is bypass. Start with a high value and lower until flicker is removed. Recommended setting is around 70%.
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13. BWF, Brickwall Filter with Area Isolation



About the Brickwall Filter As the name implies, the BWF provides an extremely sharp cut-off beyond a user defined point. The purpose of this is to create an accurately defined spectral content of material, intended for various types of compression processing, e.g. MPEG mastering. By doing so, and in conjunction with other tools in the DVNR system, the image quality subjected to compression can in most cases be dramatically improved. The BWF processing can be isolated to selected areas in the scene. This allows picture quality to be maintained in the artistic focus of the scene.



Controls



Brickwall Filter window



Filter Setup Cut-off Frequency Settings for horizontal filtering of the luminance:
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31 values between 2.0 and 5.5 MHz. The horizontal filtering for chrominance runs at approx. 0.55 of the above values. The vertical filtering is at the equivalent field-line cut of frequencies. Filter Type A number of different filter characteristics are available: Sharp



Sharp cut-off



X Sharp



Extremely Sharp cut-off



Diag Sharp



More diagonally sharper cut-off than vertically or horizontally



Fld Corr



You can say that the Field Correlator removes a field and recreates it by interpolating the remaining field. I.e. simulating film look. It has little effect on film based material, but dramatically reduces the resolution on video-based material containing motion. Suitable for MPEG1 compression and when using a high compression ratio.



Field / Frame mode In the Frame mode, all filtering in the BWF is done with the help of picture information from a frame, consisting of two consecutive fields. In Field mode, only picture information from one field is used.



Key Area



This small display shows the position and size of the key. Click and drag to move the key.



The BWF processing can be isolated, using an internal key shaped as a circle, to a selected area in the picture. The small display in the Brickwall Filter window will indicate the position and size of the key as well as the amount of filtering. The brighter, the more filtering. To see the key in the picture, use the View key control. Filter Level Inner/Outer The user can set the level of filtering between 0% and 100% independently for the area inside and the area outside the circle. You will have no brickwall filter effects at all if both of these controls are set to 0% or Size is set to 0 and Filter Level Outer is 0%. Slope The Slope control sets how sharp the transition between the two filter settings should be. Ranges from Low to X-Large. Low is a direct cut from inner to outer filtering level.
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Size Sets the size of the circle between 0 and 15. The value 0 means that no circle is visible and only outer filter level has any effect. When set to 15, the circle almost covers the entire picture, after which only the inner filtering level has any effect. Place Click on the Place button to position the circle. You can also click and drag the circle in the small display. Centre A click on this button centres the circle. View Key Use this control to see where in the picture the internal key (the circle) is placed. Areas with none or a small amount of filtering will be dark while areas with a high filtering level will be bright.



Operation Using the BWF on text If you want to highlight (or not soften) some areas in the picture, like text, use the area isolation: Start with a low (or none) Inner Filtering Level and a high Outer Filtering Level. Select 3.0 MHz or your normal settings as cut-off frequencies Set size to 7 Click on centre Activate View key Centre the circle to the text using the Centre button Adjust the Size control so that the circle covers the text Deselect View key Adjust both filter levels and cut-off frequencies to your own taste Adjust the slope for best result (You may have to increase the Size one or two steps if the outer filtering starts affecting the outer parts of the text)
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14. AGR-IV - Adaptive Film Grain & Noise Reduction



About Adaptive Film Grain & Noise Reduction AGR-IV is Digital Vision’s latest film grain and electronic noise reducer aimed for film, videotape restoration and MPEG pre-processing. The AGR-IV’s advanced motion processing and newly developed adaptive 3-D filters including an Edge Preserving Spatial Filter allow facilities to produce even cleaner and sharper pictures from film and video originated material than ever before. The AGR-IV has a greatly improved overall performance, by more sophisticated motion adaptation, low retention framestore and extensive filter selection to match source material. AGR-IV is not only Digital Vision’s fourth generation film grain and electronic noise reducer, it is also based on the new DVNR real-time processing engine.
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Controls



General The selection of Video/Film Fine/Film Normal/Film Coarse (in the AGR-IV menu) adapts the temporal filtering in respect to grain size. 3/2 pulldown for Film24/60Hz is supported. Note! Video mode is currently not implemented, use Film Fine instead.



Temporal Filtering The newly redesigned Temporal/Recursive filters allow for increased grain and noise reduction with reduced motion artefacts. AGR-IV provides the choice of RGB or YUV processing (in the AGRIV menu). YUV processing is recommended for most applications. Use Temporal Strength to set the amount/level of temporal filtering. Values up to 7 supports more subtle levels of filtering with higher precision, while values above 7 boost the filtering. A special function can Lock the three RGB or alternatively the two UV settings together.
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The AGR-IV is an Adaptive grain and noise reducer and thus disables the temporal/recursive processing of all moving edges within the image to assist in the reduction of motion artefacts. Global Temporal enables filtering of the whole picture regardless of motion (may cause excessive smearing in the picture) for maximum temporal filtering.



Spatial Filtering The Edge Preserving Spatial filtering complements the adaptive temporal filters by processing grain and noise in portions of the image that are detected as moving while living non-moving areas unaffected. The spatial filtering is done “upstream” of the temporal filters and works in unison with the AGR-IV’s motion processing. The Edge Preserving Spatial Filter is set up based on the grain/noise size in width (pixels) / height (lines) and a threshold (i.e. width=7, height=5 is a 7x5 pixel filter). The threshold determines when to filter depending on the intensity of the surrounding pixels. If there is a high enough intensity/contrast (e.g. an edge) between the grain/noise and surrounding pixels, filtering will not occur. A low setting will only affect low intensity pixels (flat areas) while a high setting will start to affect high intensity pixels (edges) The amount/level of spatial filtering is set by Spatial strength. Global Spatial enables filtering of the whole picture by switching of the motion adaptation (may cause excessive softening of the picture if the Spatial filter is not set up correctly). A moderate level of Global Spatial filtering can be used as a “basic” level of grain and noise reduction before using the temporal filtering.



Optimising the Spatial Filter 1. Set Spatial Strength and Spatial filter setup (Width/Height, Threshold) to maximum 2. Set Global Spatial to On 3. Adapt the spatial filter to the noise/grain size by decreasing Width/Height in the Spatial filter setup to as low values as possible still with grain/noise being removed 4. Decrease Threshold in the Spatial filter setup until edges are not affected (a typical setting is around 8-20%) 5. Decrease Spatial Strength until a desired level of spatial filtering is achieved 6. Choose whether Global Spatial should be set to On (filtering of the whole picture) or Off (filtering only in areas with motion)



Chroma Adaptation 3 independent channels of chroma adaptation with a hue resolution of approx. 1° allows adjustment of noise reduction levels (both spatial and temporal) in the regions of the selected colour. Only colours with a higher saturation of approx. 5% will be detected. Select a colour in one of the chroma adaptation channels. Note! The Eye dropper is not implemented in this version.
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To accurately see which parts of the picture that are affected by the Chroma adaptation, enable the View function to the right of the Chroma adaptation area in the AGR-IV window whereupon the areas in the picture affected by the chroma adaptation will remain coloured and the areas not affected will turn monochrome. The adaptation includes a soft edge that will not be visible in the View mode. Adjust Hue and/or Width if necessary to isolate the colour further. After selecting the colours using the chroma adaptation, the operator may use the corresponding Chroma trim control to adjust the grain/noise reduction for each selected colour. Chroma trim allows for the boosting or cutting of both the spatial and temporal filter settings within the selected colour.



Pos/Neg Profile The Pos/Neg profile allows the user to select the amount of noise reduction (both spatial and temporal) applied to the highlights or lowlights within the picture. This function is important when dealing with grainy images in positive or negative film stock. Positive film will generally show more grain in the lowlights. Negative film will generally show more noise in the highlights Select Pos or Neg mode (in the AGR-IV menu). Pos/Neg Trim will adjust the noise reduction levels equally for all YUV/RGB channels in highlights (Neg) or lowlights (Pos). The range of the luminance values affected by the Pos/Neg trim can be set by two thresholds. The Pos threshold can be between 0% to 50% luminance and the Neg threshold between 50% and 100% luminance.



Noise Reduction level



Noise Reduction level luminance level



Pos Trim



luminance level



Pos Threshold



Viper Key Area For the demanding jobs, a key area provides dual processing. The Viper area isolation includes two basic key shapes (rectangle or ellipse) to choose from with full control of size, aspect and rotation. Channel A (main) and channel B (key) corresponds to the dual processors where channel A works outside and channel B inside of the defined key area.
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If the key area is disabled, channel A is used. First activate the area key, by checking Area enabled, then select type of shape, rectangle or ellipse, you would like to use. Channel A noise reduction is applied outside of the area key while channel B noise reduction is applied inside (the inner line of) the area key. The adjustable Slope (the area between the two lines) provides soft transitions between the two channels. To see the area key on the video monitor while adjusting the controls, check View area key.



Miscellaneous A Split function can be used to compare processed against the original source material. When enabled, the upper part of the picture is processed while the lower part is bypassed. Freeze does a frame freeze useful to capture the effects of the Temporal filters.



AGR-IV menu
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15. ASC-II, Advanced Scratch Concealment



About Scratch Concealment The ASC-II is an all-new design using the experience of five years with the ASC. The ASC-II effectively removes, in real time, the disturbing effects of film dust, dirt and randomly dispersed scratches. Even pure emulsion damages can be effectively dealt with. The proprietary and patented process is fully adaptive while retaining full resolution of the image. Its versatility is outstanding allowing it to be used for material previously considered to be lost, to the final touching up of virgin negative transfers. In tape mode, the ASC-II allows concealment of artefacts related to video recording media, typical examples are 2" Quad dropouts, Betacam "bearding" and digital bit errors as well as FM threshold noise. A unique function giving users a very powerful tool is the keyer function. In a separate window, it is possible to set different processing parameters. This function can be used to remove very big spots without affecting the rest of the picture or do a copy-and-paste for flash-frames in real-time. In terms of film dirt concealment in real time, the ASC-II sets a new standard.
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Controls



ASC-II window



Set Origin in the set-up window to the correct mode. Video if the material is shot with a video camera. Film xx fps if it is shot with a film camera (or if input is directly from a Telecine). The film frame rate it was shot at has to be set too. Note! The ASC-II does not work as good (if at all) if these settings are not correct. Motion Set 0 to start with. This is NOT equal to no filtering. It is equal to maximum motion sensitivity. If you think there is not enough filtering in moving parts of the picture, then increase “Motion” in steps. Motion set to 15 = no motion adaptation at all. Contrast Set to around 8 or 9. Lower if you have very high contrast white spots on dark background or black spots on bright background. Higher if the luminance difference between the spots and the background is less.
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set Contrast to a high value



or



set Contrast to a low value
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Checkbox Black is to be selected if there are black spots to be removed and White checkbox should be ticked if there are white spots to be removed. Both can be ticked at the same time. If neither is ticked ASCII will not filter at all.



Filters Filter selection depends on your material. The filters have been optimised for video and film separately: Origin = Video



Origin = Film



Small Mix



Small Mix



Medium Mix



Medium Mix



Large Mix



Large Mix



X-Large Temp.



X-Large Temp.



1-D Small Spat.



S-Cross Spat.



S-Cross Mix



L-Cross Spat.



L-Cross Mix



S-Cross Mix



XL-Cross Mix



L-Cross Mix.



1-D Large Temp.



S-Cross Temp.



L-Cross Temp.



M-Cross Temp.



XL-Cross Temp.



L-Cross Temp.



Copy Prev



Copy Prev



Copy Next



Copy Next



Note! The top four filter types are identical to the filter types in the old ASC and have been kept in the new design for compatibility reasons. Using the other filters instead will further improve filtering performance. 1-D These filters only have vertical taps in the current field and should be used to remove line dropouts and FM sparks in video-mode. Spatial All filters named Spat. (Spatial) are filters working only within current frame (or field if video mode), i.e. it has “taps” only in current frame. They are for very small spots.



Mix All filters named Mix have taps in both current frame and the frame previous to and following current frame. I.e. it has both spatial and temporal taps. All these filters however have more taps in current frame than in the previous and following together (more spatial taps than temporal). These filters are for normal spots.
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Temporal Filters called Temp. (Temporal) at the end have both spatial and temporal taps but more temporal than spatial. This will enable the ASCII to remove any size of spots. These filters may need more care, to not give unwanted artefacts.



Copy Filters Copy Next and Copy Prev should be used for 1 frame in combination With the Keyer and Global mode to replace a big chunk of dirt, a big hole or a flash frame with information from next or previous frame.
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Keyer You have two different “channels” to set parameters in. They are called “Main Area” and “Key Area”. Use the key area for very special problems like very big single spots or flash frames at film cuts. Turn on key area To use the “Key Area” tick the box Use Key located in the “Area Isolation” part of the window. Define area Define the area by clicking on Place. First place your upper left corner of your box by moving the mouse to the desired position then click left button and hold. Then move the lower right corner and release the mouse button. Set parameters Set all parameters for the key area to desired settings.



Special controls: Edge Sometimes when you have material with fine structures (e.g. houses from a distance or a forest) and there is a slight weave present, you may see unwanted artefacts from ASC-II. If you the tick the box Edge, the built in edge detector will affect were ASC-II filters. It will reduce filtering were it finds edges. Global-C If you want more filtering in chroma than you have with selected settings and don’t want to change filtering for luminance you can set Global-C by ticking the box. Global filtering will be applied for chroma (all pixels will have their chroma filtered) but WITH motion adaptation and (if selected) edge detection still working. It is not the same as selecting “Global”. This control affects both Main Area and Key Area. Global If you want to turn the adaptation off completely tick the box “Global”. You can then set the amount of filtering with Level. 0 = bypass and 15 = all pixels are 100% filtered (using selected filter). H-Split Demonstration mode where the upper half of the picture is processed while the lower part is left unprocessed for comparisons. V-Split Demonstration mode where the left part of the picture is processed while the right part is left unprocessed for comparisons.



ASC-II menu Bypass When enabled, the ASC-II is put into electronic bypass.
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Operation Removing big spots with the Keyer •



If you have a big spot in one frame that is not removed with the filter settings you have for your “Main Area”, make an event at exactly the frame were the big spot is.



•



For this event turn on Key Area. Put your keyer over the spot, Select Global for the key area and select filter size “COPY NEXT” or “COPY PREV”.



•



If it is the first frame after a cut you must select “COPY NEXT” and likewise if it’s the last frame before a cut you must select “COPY PREV”. Set Level to 15 in your key area you will get a copy-and-paste from next frame to current in real time!



•



On the first frame after the frame with the spot, set another event and deselect Use Key to go back to using settings for “Main Area” for the whole picture.
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16. ASC-II+, Advanced Scratch Concealment



About Scratch Concealment The ASC-II+ is a new High Definition scratch concealer based on the industry standard ASC-II. With new filters and enhanced Motion Adaptation, the ASC-II+ further reduces the need for manual paintwork or non-real time processing. The ASC-II+ effectively removes, in real time, the disturbing effects of film dust, dirt and randomly dispersed scratches. Even pure emulsion damages can be effectively dealt with. The proprietary and patented process is fully adaptive while retaining full resolution of the image. Its versatility is outstanding allowing it to be used for material previously considered to be lost, to the final touching up of virgin negative transfers. A unique function giving users a very powerful tool is the keyer function. In a separate window, it is possible to set different processing parameters. This function can be used to remove very big spots without affecting the rest of the picture or do a copy-and-paste for flash-frames in real-time. In terms of film dirt concealment in real time, the ASC-II+ sets a new standard.
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Controls Click on the ASC button at the top of the workspace or select ASC from the Image panel to access the ASCII+ controls.



ASC-II+ window



Set Origin in the set-up window to the correct mode. Video if the material is shot with a video camera. Film xx fps if it is shot with a film camera (or if input is directly from a Telecine). Note! The ASC-II+ does not work as good (if at all) if these settings are not correct. MDC The MDC (Motion Detection Current) determines whether to look at the previous and next field/frame or the previous, current and next field/frame. If set to On, this mode ensures higher sensitivity and reduces artefacts down to a minimum. For maximum filtering, the control may be set to Off. Motion Set 0 to start with. This is NOT equal to no filtering. It is equal to maximum motion sensitivity. If you think there is not enough filtering in moving parts of the picture, then increase “Motion” in steps. Motion set to 7 = no motion adaptation at all. Contrast Set to around 8 or 9. Lower if you have very high contrast white spots on dark background or black spots on bright background. Higher if the luminance difference between the spots and the background is less.
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or



set Contrast to a high value



or



set Contrast to a low value



Checkbox Black is to be selected if there are black spots to be removed and White checkbox should be ticked if there are white spots to be removed. Both can be ticked at the same time. If neither is ticked ASCII will not filter at all.



Filters Filter selection depends on your material. The filters have been optimised for video and film separately: Origin = Film



Origin = Video



2 Pixel Spatial



3 Pixel Mix



3 Pixel Spatial



1 Line Mix



4 Pixel Mix



2 Lines Mix



6 Pixel Mix



1 Field Small Temp.



8 Pixel Mix



1 Line Spatial



12 Pixel Mix



4 Pixel Mix



16 Pixel Mix



5 Pixel Mix



20 Pixel Mix



1 Line Large Mix



1 Frame Small Temp.



1 Field Medium Temp.



1 Frame Medium Temp.



1 Field Large Temp.



1 Frame Large Temp.



1 Field X-Large Temp.



Copy Prev



Copy Prev



Copy Next



Copy Next



Line These filters only have vertical taps in the current field and should be used to remove line dropouts and FM sparks in video-mode. Field/Frame These filters have the capacity to remove a piece of dirt the size of a field/frame. Spatial All filters named Spat. (Spatial) are filters working only within current frame (or field if video mode), i.e. it has “taps” only in current frame. They are for very small spots.
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Mix All filters named Mix have taps in both current frame and the frame previous to and following current frame. I.e. it has both spatial and temporal taps. All these filters however have more taps in current frame than in the previous and following together (more spatial taps than temporal). These filters are for normal spots.



Temporal Filters called Temp. (Temporal) at the end have both spatial and temporal taps but more temporal than spatial. This will enable the ASCII to remove any size of spots. These filters may need more care, to not give unwanted artefacts.



Copy Filters Copy Next and Copy Prev should be used for 1 frame in combination With the Keyer and Global mode to replace a big chunk of dirt, a big hole or a flash frame with information from next or previous frame.



Keyer You have two different “channels” to set parameters in. They are called “Main Area” and “Key Area”. Use the key area for very special problems like very big single spots or flash frames at film cuts. Turn on key area To use the “Key Area” tick the box Use Key located in the “Area Isolation” part of the window.
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Define area Define the area by clicking on Place. First place your upper left corner of your box by moving the mouse to the desired position then click left button and hold. Then move the lower right corner and release the mouse button. Set parameters Set all parameters for the key area to desired settings.



Special controls Edge Sometimes when you have material with fine structures (e.g. houses from a distance or a forest) and there is a slight weave present, you may see unwanted artefacts from ASC-II+. If you the tick the box Edge, the built in edge detector will affect were ASC-II+ filters. It will reduce filtering were it finds edges. Global-C If you want more filtering in chroma than you have with selected settings and don’t want to change filtering for luminance you can set Global-C by ticking the box. Global filtering will be applied for chroma (all pixels will have their chroma filtered) but WITH motion adaptation and (if selected) edge detection still working. It is not the same as selecting “Global”. This control affects both Main Area and Key Area. Global If you want to turn the adaptation off completely tick the box “Global”. You can then set the amount of filtering with Level. 0 = bypass and 15 = all pixels are 100% filtered (using selected filter). H-Split Demonstration mode where the upper half of the picture is processed while the lower part is left unprocessed for comparisons. V-Split Demonstration mode where the left part of the picture is processed while the right part is left unprocessed for comparisons.



ASC-II+ Control Menu Bypass When enabled, the ASC-II is put into electronic bypass.



Operation Removing big spots with the Keyer If you have a big spot in one frame that is not removed with the filter settings you have for your “Main Area”, make an event at exactly the frame were the big spot is. For this event turn on Key Area. Put your keyer over the spot, Select Global for the key area and select filter size “COPY NEXT” or “COPY PREV”.
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If it is the first frame after a cut you must select “COPY NEXT” and likewise if it’s the last frame before a cut you must select “COPY PREV”. Set Level to 15 in your key area you will get a copy-and-paste from next frame to current in real time! On the first frame after the frame with the spot, set another event and deselect Use Key to go back to using settings for “Main Area” for the whole picture.
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17. CSR, Vertical Scratch Removal



About Continuous Scratch Removal The CSR continuous vertical film-scratch remover effectively removes disturbing effects of vertical film scratches. Even pure emulsion damages can effectively be dealt with and CSR processing can be done both tape-to-tape as well as directly in the telecine transfer process. The proprietary and patented process is fully adaptive and allows for fast and effective concealment by the use of advanced digital filtering techniques. Due to the adaptive nature of the process, only areas suffering from scratches will be processed leaving the remaining part of the image unaffected. User control allows for adjustment to select maximum processed size, length and relative inter-frame movement. The CSR offers very cost effective restoration of damaged film and largely avoids the use of manual paintwork.



Theory of Operation CSR contains a scratch detector and a median filter. The scratch detector enables the median filter only in the part or part of the picture where scratches are detected, to remove the scratches. The rest of the picture is left unprocessed. CSR also includes the Area Isolation feature. The user can select in which areas of the picture processing is allowed. This eliminates the risk of CSR removing objects that the scratch detector mistakes for being scratches e.g. flag staffs. The CSR can be set to Global mode, where the scratch detector is disabled. Instead, the user manually controls the amount of median filtering. This mode is useful in difficult situations, where the scratch detector cannot detect the scratches. Area isolation works in Global mode as well, allowing the user to only process the parts of the picture where there are scratches.
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Controls



CSR window



Scratch Detector Controls The user has a number of controls to describe the scratch to the scratch detector. All of the criteria have to be fulfilled at the same time in order to detect the scratch. The scratch detector controls are only available in non-Global mode. Filter Size



Coverage



Wobble A number of criteria have to be fulfilled before filtering



Black Attenuation of Black scratches. White Attenuation of White scratches. White and Black can be selected at the same time. Filter Size Corresponds to the width of the scratch(es) in pixels. E.g. a setting of 5 pixels will remove any scratch equal to or smaller than 5 pixels. Contrast Selects the threshold/sensitivity for the detection of scratches. If the contrast between scratches and picture information is high, set the Contrast control to a low value to minimise processing of “real” picture information. On the other hand, if the contrast between scratches and
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picture information is low, set the contrast to a high value, to enable processing of the scratches. Wobble Selects how much the scratch(es) are allowed to move horizontally and still being detected by the CSR: Small Medium Large Extra large Coverage Coverage is the length of the scratch compared to the active picture. E.g. setting Coverage to 60% removes scratches equal to or larger than 60% of the active picture.



Global Mode Controls Global Selects the Global filtering mode. In this mode, the scratch detector is disabled. Filter Size Optimises the median filter for a particular scratch width. For example, Filter Size 5 removes scratches that are 5 pixels wide or less. Level Sets the amount of global filtering. When Level is 0%, the picture is left unprocessed. When Level is 100%, maximum filtering is performed.



Area Key



This feature lets the user select in which part or parts of the picture, where processing is allowed. In non-Global mode, this eliminates the risk of the CSR removing objects that the scratch detector mistakes for scratches. In Global mode, the whole of the selected areas is processed. Click the CSR window. A vertical stripe will appear in the video picture. The stripe can be moved using the mouse/trackball.
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Select the area or areas in the video picture that contain unwanted vertical scratches by clicking and dragging using the left mouse/trackball button. If you click and drag on an area that is already selected, it becomes deselected. When you have finished selecting areas, press the right mouse/trackball button. Note! It is important to select a key area that is just large enough to cover all picture areas that contain the scratch during a scene.



Autotrack The Autotrack feature automatically moves or deselects selected areas if a scratch moves or disappears. Autotrack is useful only in a few situations. It should normally bet set to Off. Off



No action



Deactivate



This function deselects areas where no scratches are detected. This is useful for deselecting areas when a scratch disappears, e.g. after a scene change. If a new object that the scratch detector may mistake for a scratch appears in the same position later, it is not processed since the area is not selected anymore.



Widen



Widens the selected area if a scratch tends to move out of the selected area.



Follow



Moves selected areas, letting them follow a moving scratch.



In most cases, however, setting Autotrack to Off and manually selecting areas that are wide enough for the scratch movement, is good enough.



Miscellaneous Controls Slope At Slope setting 0, the horizontal median filtering cuts in and out directly. Higher settings of Slope cause the filtering to gradually increase and decrease around edges of the detected scratch. This removes some of the ringing, which normally appears on the sides of a high contrast scratch. The slope also gives a good result when using global filtering and area isolation. Show hit Click on Show hit At bottom or At top in the CSR window. A status display bar appears in the picture as shown below:
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Area Key Status Bar



Scratch Length Filter Activated



The Status Bar



The Status Bar helps you to optimise the CSR settings. It contains three fields: The Area Key (top) field shows the selected area key. The Scratch Length (middle) field displays the scratch length using a grey scale. The field shows the effect of the following controls: Black, White, Contrast, Filter Size and Wobble. The Filter (bottom) field indicates where the median filter is activated. In non-Global mode, this field shows the effect of the Coverage and Slope controls. In Global mode, it shows the effect of the Level and Slope controls. Note! If the lower field of the status bar shows no activity, the CSR is not being triggered by any scratches within the key area. Split Demonstration mode where the upper half of the picture is processed while the lower part is left unprocessed for comparisons.
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Operation General The following approach can be used to optimise the CSR settings: 1. Select non-Global mode and Autotrack Off.



2. Set Area Key where the scratch or scratches are.



3. Activate the Status Bar.



4. Set Black and/or White depending on the scratch type.
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5. Set Coverage, Contrast, Filter Size and Wobble to maximum. 6. Adjust Contrast, while looking at the Scratch Length (middle) field in the Status Bar. Try to make the Scratch Length field as bright as possible where the scratches are, while keeping it as dark as possible elsewhere.



7. Lower Coverage until the scratch disappears. Look at the Filter (bottom) field in the Status Bar.



8. Lower Filter Size until the scratch reappears. Go back one step on the Filter Size control. 9. Check if lower settings of Wobble can be used. 10. If too much filtering is applied to the rest of the picture, try fine tuning Contrast and Filter Size. 11. If the scratch detector has difficulties detecting the scratches, try Global mode and adjust Level. 12. Try out different Slope settings. Tip! When applying CSR filtering, try to increase Noise Reduction slightly so that the effect of the CSR filtering is not so apparent.



User's Manual



CSR, Vertical Scratch Removal • 87



88 • CSR, Vertical Scratch Removal



User's Manual



18. ACP-Viper



About ACP-Viper ACP is Digital Vision’s third generation Colour Corrector aimed primarily for advanced tape-to-tape colour correction. For the demanding jobs, the Viper option provides a power boost with dual parallel primary and secondary colour correctors including advanced Viper keying between the two. The Viper includes two basic key shapes to choose from with full control of position, size, aspect and rotation.



Primary Colour Corrector The internal signal processing of the primary colour corrector is structured around four channels, one luminance path and three chrominance paths, Y+RGB, each one processed with the same bandwidth. Further, the internal processing uses higher number of bits as required to avoid truncation (rounding off) errors. This is especially important for certain parameters like gamma correction in order to avoid any stepwise action of the curve. The use of the Y+RGB paths allow luminance gain and black changes to be made without affecting or needing to realign colour balance. Inversely, when grading colour, the luminance level remains constant. The ACP also features user definable transfer functions and thresholds for black, gamma and gain control, which are useful when perfect match in the primary colour correction stage is required.



Secondary Colour Corrector The secondary colour processor offers six functionally parallel channels/vectors with independent discrimination and processing in the Hue, Saturation and Luminance domains.
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Primary Controls



Primary “Standard” view



Primary “Classic” view



Click on the ACP button at the top of the workspace or select ACP from the Image panel to access the Primary controls of the ACP. To switch between the two views as shown above, go to menu View > Primary Channels The Viper option enables dual parallel primary and secondary colour correctors including advanced Viper keying between the two. Channel A and B corresponds to the dual colour correctors where A works outside and B inside of the defined key area. If the key area is disabled, channel A is used. More information about the Viper keying is available further on. Black Adjusts dark parts of the picture: slider for luminance adjustments, trackball for red, green and blue individually. Range: -25% - +25% of the full video amplitude.
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On the Colour panel use leftmost trackball for RGB settings and corresponding ring for luminance setting. Gamma Adjusts grey parts of the picture: slider for luminance adjustments, trackball for red, green and blue individually. Range: 0.50 - 1.99 (Normally set to 1.00). On the Colour panel use middle trackball for RGB settings and corresponding ring for luminance setting. Gain Adjusts light parts of the picture: slider for luminance adjustments, trackball for red, green and blue. Range: -100% - +99%. On the Colour panel use rightmost trackball for RGB settings and corresponding ring for luminance setting. Master Hue is used to control the colour tone (chroma phase) by rotating the phase of the colour circle. Range is -180 to +180 degrees. Master Saturation Increases or decreases the chrominance level. The possible gain is in the range -100% - +100%. Clear all Clears all parameters found in the Primary Colour Correction window when activated.



Master & RGB Thresholds With the threshold controls it is possible to set from which point in the grey scale up to white Gain should work or from which point in the grey scale down to black the Black control should work as shown below. Gamma has two thresholds.



The thresholds can be set directly in the diagram by left-clicking. Rightclick to set Gamma upper threshold. Master & RGB Lift Normally Black is a linear function between black and white, where white is “untouched” by the Black control. However selecting Master Lift, the Black control adds the change independent of original luma level. Similar operation for RGB.



The effect of Lift (to the left) compared to Stretch on a Luminance ramp



To go back to the normal view, click on Less.
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Video Gain In addition to the Master Gain and Master Saturation controls, a separate Video Gain control is available.



ACP Menu



Primary settings copy Provides different options of copying settings between/to channel A and Channel B Bypass When enabled, both Primary and Secondary is put into electronic bypass. Clear Clears both Primary and Secondary settings.
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Secondary Controls



“Standard view”



“Classic” view



The Secondary Colour Corrector is divided into two parts: The Analyzer and the Processor. With the Analyzer you search for a colour to change and with the Processor, you change it. Click on the ACP button at the top of the workspace or select ACP from the Image panel to access the Secondary controls of the ACP. To switch between the two views as shown above, go to menu View > Secondary Channels The Viper option enables dual parallel primary and secondary colour correctors including advanced Viper keying between the two. Channel A and B corresponds to the dual colour correctors where channel A works outside and channel B inside of the defined key area. If the key area is disabled, channel A is used. More information about the Viper keying is available further on.
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Analyzer The Analyzer is the part of the Secondary that detects colours in the picture for the Processor to work with. It has 6 independent vectors to work with. Vector select Click one of the six coloured buttons to select the vector you want to work with. The vectors default to magenta, red, yellow, green, cyan and blue. The colour of the button will change depending on how you set the analyzer. Below each vector select button, there is a small indicator or “LED”. The indicators will light up to indicate vectors in use. When clicking on the All button, the colour display will show the location of all six vectors. Center Sets the centre-point of the selected control (Hue/Sat/Lum) and vector. Width Sets the width / range of selected control and Vector. The picture below shows the effect of the central point and width on Hue and Saturation of a vector:



Slope Defines the slope (soft edge) of the selected control and vector. Width



N



M



W



The different slopes: Narrow, Medium and Wide



Eye-dropper Instead of setting the centre-points manually, you can use the Eyedropper button. Click on it and a cursor will appear on the video monitor. To discard, click on the right mouse or trackball button. To accept, click on the left one and centre-points for the selected vector will automatically be set.
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Cursor on video monitor when Eye-dropper is selected



Eye-dropper + By clicking on adjacent areas to the “hit area”, the “width” will be enlarged and will include these colours in the “hit area” as well.



Processor The Processor is the part of Secondary that performs the changes of the picture content as follows: Hue Changes the chroma phase for the selected channel. Range is -180 to +180 degrees. Sat Amplifies or attenuates the chrominance of the selected channel. Lum Amplifies or attenuates the luminance for the selected channel. Additive Luminance Adds instead of multiplies the selected value to the luma level. Additive Saturation Activate the Additive Saturation for colouring of areas with low saturation and where the resulting colour needs to be highly saturated. Clear This Clears both Analyzer and Processor settings for the selected vector. Clear all Clears Processor settings Hue, Saturation and Luminance for all vectors and sets default values for the Analyzer.
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ACP Menu



Secondary settings copy Provides different options of copying settings between/to channel A and Channel B Bypass When enabled, both Primary and Secondary is put into electronic bypass. Clear Clears both Primary and Secondary settings.



Multiplicative to the left and Additive to the right (incl. slopes) affecting a luma or chroma ramp



Viper keying For the demanding jobs, the Viper provides a power boost with dual parallel primary and secondary colour correctors including advanced Viper keying between the two. The Viper area isolation includes two basic key shapes (rectangle or ellipse) to choose from with full control of size, aspect and rotation. Channel A and B corresponds to the dual colour correctors where channel A works outside and channel B inside of the defined key area. If the key area is disabled, channel A is used.
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First activate the area key, by checking Area key enabled, then select type of shape, rectangle or ellipse. Channel A colour correction is applied outside the black line of the area key while Channel B colour correction is applied inside the grey line of the area key. The adjustable Slope (the area between the black and the grey line) provides soft transitions between the two channels. To see the area key on the video monitor while adjusting the controls, check View key.



Positioning the Area Key The area key can be positioned in a number of different ways by: 1. Pushing the Place key on the Colour or Image panel and moving the mouse/trackball. 2. Dragging the visible area key with the mouse in the Area window. 3. Using the spinboxes in the Area window.
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Re-sizing or Rotating the Area Key The area key can be re-sized and rotated in a number of different ways by: 1. Using the controls on the Colour or Image panel. 2. Using the Area Key display in the Area window. Re-sizing: Hold the right mouse button and move the cursor Rotating: Hold down the left + right mouse buttons and move the cursor. 3. Using the spinboxes in the Area window.



Copying Channel Settings To copy channel A settings to channel B, use one of the following approaches: 1. Use the controls on the Colour or Media panel 2. Select Copy Settings: A to B or Copy Settings: A to B in the Control menu
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19. CD, Colour Desaturation



About Colour Desaturation The CD option, colour desaturation is the process of removing or decreasing colour saturation below and above an adjustable luminance level. This process greatly simplifies certain types of telecine work where considerable effort would be required by the use of conventional colour correction techniques in order to correct severe colour imbalances. Since desaturation can be made both above and below a preset level, negative and positive film processing is catered for. Similar in appearance to film, errors may occur in the video domain. This is often due to incorrect white balancing or mix of colour temperatures during a shot. Also, cameras that are forced into extreme high and low lights may cause RGB imbalance.



Controls



Chroma Desaturation (CD) window.



Cutoff Sets the luminance level where minimum desaturation, 0%, is performed.
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Knee Sets the luminance level where maximum desaturation (according to desat level) is performed The desaturation between the 100% threshold and the Desat threshold is a linear function. Chroma Desat Sets the amount of Chrominance Desaturation to be performed between the following luminance levels: Max. White (Super White) to Desat Threshold High Max. Black (Super Black) to Desat Threshold Low Clear Clears or sets the Colour Desaturation to its default values.



Panel controls Page 1 selects lowlight controls. Page 2 selects highlight controls.
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20. AC, Aperture Correction



About Aperture Correction After all processing, the signal can be further enhanced by a twodimensional aperture corrector. The aperture processor normally increases response to high frequency content in the signal, thus adding subjective sharpness to the picture. Aperture correction should be employed as the last process in the chain to avoid increase of the overall noise level. The Aperture Corrector is a standard feature in the DVNR image processing system.



Controls



Aperture Correction (AC) window.



Filter Type Selects one of four possible filters:
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Normal



Normal Aperture Correction



Diagonal



More horizontal/vertical than diagonal detail enhancement



Soft



Softens the picture



Extra



Stronger and larger steps than Normal
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HAC Amount of Horizontal Aperture Correction. Range is 0-7, where 0 is bypass. VAC Amount of Vertical Aperture Correction. Range is 0-7, where 0 is bypass.
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21. AAC, Advanced Aperture Correction



About Advanced Aperture Correction Detail processing for both film and video can be achieved by the AAC, Advanced Aperture Corrector. Typically it will be one of the last processes carried out in the digital video path, post of noise reduction, film dirt concealment, various filtering and the critical non-linear manipulation in the primary and secondary colour corrector. Several features put the AAC apart from any other type of aperture correction available. Firstly it can operate in either field or frame mode. The latter case addresses film originated material where traditional field based correction is unsuitable. In addition, provision for independent lift or reduction (softening) of detail in high and lowlights is possible as well as selection of actual detail size by adjustable frequency sweep. Details may also be selected on basis of colour hue where the user selects a chrominance range to be corrected. This unique function offers the possibility to correct such visibly sensitive areas like human skin but also to process mattes for better keying results.
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Controls



Advanced Aperture Correction (AAC) window.



Field / Frame mode In the Frame mode, all filtering in the AAC is done with the help of picture information from a frame, consisting of two consecutive fields. In Field mode, picture information from one field only is used. Field/Frame mode is selected in the AAC menu. Filter Type Selects one of the following filters: Normal



Normal Aperture Correction



Diagonal



More horizontal/vertical than diagonal detail enhancement (preferred setting)



Soft



Softens the picture



Extra



Stronger and larger steps than Normal



Highboost



Boosts the signal above a selectable frequency



Peak/Cutoff



First Peak then cut-off at selectable frequency



Peak



Peak at selectable frequency



Inverse



Inverts the luminance



Edge



Effects only



Filter Characteristics: B



Gain +6dB



Freq.



“Highboost” filter
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Gain



P



Freq. -6dB C



“Peak/Cutoff” filter



Gain



P



Freq.



“Peak” filter



Boost frequency is defined at +6dB (VAC=7/HAC=7). Cut frequency is defined at -6dB (VAC=7/HAC=7) The vertical filtering is at the equivalent field-line cut of frequencies. Note! For HDTV, the cutoff frequency displayed should be multiplied by a factor of 5.5 HAC Amount of horizontal Aperture Correction. Range is 0-7, where 0 is bypass. VAC Amount of vertical Aperture Correction. Range is 0-7, where 0 is bypass.



Adaptation



AAC Adaptation



Colour Adaptation By selecting the Colour control, it is possible to Cut or Boost Aperture Correction within an area of a specific colour. The last two colours are Skin Tone, specially set for skin tones (where both hue and saturation discriminates selection) and Monochrome
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where saturation has to be below a certain (low) value for Cut or Boost of noise reduction in monochrome areas. Luminance Adaptation Theses two independent controls determine if a cut or a boost of aperture correction is to be applied to the defined areas in black and/or in white. If the scrollbar is set to 0, the corresponding Cut/Boost control has no effect. The red grid will show the luminance ranges where the boost or cut of aperture correction will be applied. Coring or edge detection. A low setting will apply aperture correction on most edges while a high setting will restrict aperture correction to high intensity edges.
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22. ZOOM



About VZOM & HZOM The VZOM option mainly addresses the needs for vertical conversion and positioning between film (up to 2,35:1) and video (4:3/16:9) formats using an electronic film master (e.g. D1 tape) To change the aspect ratio in the digital video domain instead of making a new telecine transfer also provides a number of additional advantages. Overall higher and more consistent picture quality as well as better control over aliasing (line twitter). The latter is especially important when going to letter-box formats. Normally the VZOM is used to compress an anamorphic picture but can also be used to convert 4:3 tape stock to 16:9 format, e.g. for PAL-Plus transmission. This is achieved with the VZOM expanding the image 25% in the vertical direction. The HZOM option mainly addresses the needs for "Pan & Scan" processing converting between film (up to 2,35:1) and video (4:3/16:9) formats using an electronic film master (e.g. D1 tape). This is of particular interest in HiRes1440 because full 4:3 bandwidth can be maintained through the "Pan&Scan" process even for 2,35:1 Cinemascope originated material. The small 4% difference in PAL and NTSC active line can also be corrected fully in the digital domain by the HZOM process option. In addition the VZOM together with the HZOM can be used to restore full active picture after DIS, Digital Image Stabilisation. To meet the exceptional high quality requirements Digital Vision has developed a range of proprietary conversion filters.
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Controls



Zoom window



Processing Vertical Frame Filtering Mode In the Frame Filtering Mode, all filtering of the VZOM option is done with the help of picture information from a frame, consisting of two consecutive fields. When not in Frame Filtering Mode, picture information from only one field is used. Anti-Alias A filter with slower vertical roll-off that removes inter-field flickering when activated. The combination of the two controls Frame Filtering mode and AntAliasing Filter results in filtering as follows: Frame Filtering



Anti-Alias



Result Field Filter, no Anti-Alias



X X



Frame Filter, no Anti-Alias X



Frame Filter, medium Anti-Alias



X



Frame Filter, maximum Anti-Alias



Aspect Sets the vertical aspect ratio (compression/expansion). Position Positions the output picture vertically.



Horizontal Aspect Sets the horizontal aspect ratio (compression/expansion).
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Position Positions the output picture horizontally. Can be used in a dynamic to create a pan&scan. Tip! To clear both vertical / horizontal aspect and position, select “none” in the Format Preset drop-down list of the Setup page. Field Interpolate Normally every parameter is updated on a frame basis during dynamics and cuts. But when this control is ticked, the horizontal position will change every field during a dynamic to give a smooth pan&scan. Preview



Preview mode



Final output



When you are using horizontal aspects greater than 1 (zoom out), you can activate the preview mode (left picture) to see exactly which parts of the picture (dimmed) will be omitted in the final output (right picture). The preview mode can be enabled independently of the list and dynamics.



Global Global Zoom; Changes horizontal and vertical aspect ratio (compression/expansion) simultaneously.



Presets



The Format Presets provides pre-defined settings for the most commonly used aspect ratios.
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23. Miscellaneous DVNR controls



Test Pattern



Test window



The test patterns are located on the input interface board of the DVNR and can be used for alignment and troubleshooting e.g.: Colour Bars:



Aligning DAC board



Ramp:



Checking for bit errors



Pattern Selects one of the internal test patterns (test button will show the selected pattern): Insert Inserts 64 lines of the selected test pattern on top of the input picture. Monochrome Sets video to black/white (colour difference signals set to 128, 8 bit notation).
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Blanking



Blanking window



Vertical re-blanking Vertical re-blanking is a standard feature of the Digital Vision image processing system and independent Upper and Lower blanking is supported. This is particularly useful e.g. after Colour Correction of wide screen formats or after Image Stabilisation. Several preset formats are selectable as well as possibility for customisation. Horizontal re-blanking Horizontal re-blanking adjustment in the range of 0 to 15 pixels (on each side). Presets A number of pre-defined blankings are available at your disposal. Select Custom to set a blanking that does not exist as a Preset.
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24. System Setup



System



DVNR Selects the type of DVNR connected and at which baudrate it communicates with the Valhall control system. Default baudrate is 230400.



VTR Set the number of VTRs connected. This affects the appearance of the Edit dialogue.
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DVNR



Set-up which DVNR Image Processing options that are installed.



Timing



The parameters in the System timing window are used for trimming Autoshot and parameter execution timing. Autoshot trim Adjusts the timing between the timecode source and the scene change detector in the DVNR.
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Film 24 Phase trim Adjusts the 3:2 phase controlled from the list. List Trim Adjusts the timing between the timecode source and the parameters executed in the DVNR at an event.



VTR



The VTR tab sets up the default behaviour of the connected machine. Alias The user definable alias is used to easily identify each machine. Edit Type This is where you set up if the machine is a player or a recorder. To exclude a machine when editing, select Ignore. Master Defines the master timecode source. All offsets entered are relative to the master. Setup The Edit delay trims the edit points on the recorder while the Offset compensates for the delay between the player and recorder introduced by other equipments. Audio Use this control to indicate the Audio capabilities of the machine, since this is not automatically detected. TC Normally set to Auto. On some tapes, however, LTC may differ from VITC. In this case, select the timecode source that is correct.
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Playspeed filter The playspeed filter is used to e.g. prevent false autoshots as the machine goes from stop to play.
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25. Image Panel



About the Image Panel



The Image panel handles the list management of the Valhall system as well as controlling Noise Reduction, Scratch Concealment and other options (except Colour Correction operations requiring trackballs).
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Controls Display



Key Area setup A/Main



Bypass



1



Clear



2



Area



3



A



B



Menu selection



B/Key



Wipe keys



Lock



1



Hold



2



Single



3



Up/Down keys



Mode selction



Page selection



Byp All



Save



Still



BookM



All



Select



List



Note



Undo



Redo



Orig



Prev



Delete



Frame



Event



Clear



Dyn



Trim



Mark



Recall



Shift



Wipe wheel Page selection F1



F2



F3



F4



M1



M2



M3



M4



Programmable Function keys Trackball keys



Enter



Valhall key List operation Integrated Trackball



See Appendix A, Panel Keyboard Reference for detailed information on available keyboard commands



Keys Most keys have a built-in LED that shows the status. The brightness can be set in the User Profile window under the Panels page.



Knobs Each knob has a built in push-button switch, which is mostly used for clearing the parameter corresponding to the knob. To clear, the knob has to be held down for a longer period of time (determined by the User Profile).
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Tip! Each processing window provides an acceleration setting for the controls used (trackball, rings or knobs).



Display As there is no panel-print for the different functions/parameter accessible from the knobs and buttons, labels and values are shown on the display. Activated functions will be shown as a box with the text inverted Tip! You can change the brightness of all displays under the Panels page in the User Profile dialogue.



Menu Selection Use the keys above and below the smaller menu selection display to select the processing option to control. Normally this operation also opens the processing window in the GUI (if enabled under the Panels Page in the User Profile dialogue). Press and hold to close the window. If options will not fit on the display, use the Page selection (1-3) keys. Press and hold a page selection key to close all processing windows on that page. Tip! By pressing the Valhall key followed by a Menu Selection key, bypass will be toggled for the corresponding processing option. To clear or set the processing option to unity, first press the Shift key and then the Menu Selection key.



Mode Selection Most keys on the Image panel are assigned for List operation. However, these keys can also be used for Notes, Bookmarks and Stillstore operation. This is determined by the Mode selection keys.



Up/Down keys These generic keys are assigned to various types of navigation depending on the mode selected.



Wipe Wheel This generic high-resolution wheel can be assigned to various operations depending on the mode selected. Wipe Keys The Wipe keys are associated to the mode and function of the Wipe wheel.
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List Operation keys The List operation keys allow you to control and modify the event list and timeline. Most of the List operation keys can be assigned for Notes or Bookmark operation.



Programmable Function keys Pre-defined functions can be mapped to the programmable function keys. Modifier keys Valhall and Shift can be used to access another three sets of functions. Labels F1-F4 and M1-M4 does not restrict the key usage to functions and memories. The function keys are defined in the User Profile window under Image keys.



Processing Controls The controls surrounding the larger display are used for processing controls. Page selection keys 1 – 3 are used when more controls are available than will fit on one page. The Area key can be pressed to access the Area key controls for certain processing options. When an Area is enabled, keys A and B will switch between Main (A) and Key (B) processing controls. The Bypass key is used to set the processing to electronic bypass. When pressing the Clear key, the settings for the selected page will be cleared (set to unity). Press and Hold to clear all settings for the selected option.



Modifier keys



Valhall key



The modifier keys (Valhall, Shift & All) provide additional functionality when used together with other keys. A modifier key is either pressed and released before selecting the second key or held wild pressing the second key.



Trackball The trackball, with the five corresponding buttons (layout for both leftand right-handed persons), is mainly used to navigate in the Windows environment. The button closest to the middle and the button furthest away are compatible with the standard two-button mouse. Use your thumb to move the trackball. The middle button is used to activate the eye-dropper of the ACP secondary.
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26. Media Panel



About the Media Panel
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Controls Display



Numerical keypad



Edit controls



Cue



Asmbl



+



7



8



9



Edit



Rec



-



4



5



6



Preview



Review



*



1



2



3



In



Out



,



0



00



C



VTR 1



Valhall key



VTR 2



VTR3



VTR4



Enter



Jog



Programmable Media Transport keys Search dial



See Appendix A, Panel Keyboard Reference for information on available keyboard commands



Keys Most keys have a built-in LED that shows the status. The brightness can be set in the User Profile window under the Panels page.



Display The display shows the current position (timecode) and status of the VTRs. The brightness of the display can be changed under Panels in the User Profile.
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Numerical Keypad The numerical keypad is mainly used to enter numbers or timecode for specific operation. Normally the number/timecode is entered before applying the operation thus reducing the number of keystrokes. Absolute and Relative Entries Both absolute (unsigned) and relative (signed) entries are supported for most operations. The “+” and the “-“ keys are used for relative entries. Field selection The key with the asterisks (*) toggles field 1 and 2 for timecode entries. An asterisk means field 2. Clear The Clear key (C), when pressed, deletes the last entered digit. To clear the whole entry, press and hold. Tip! Leading zeros does not have to be typed in. E.g. 2:21 corresponds to timecode 00:00:02:21.



Tip! To further reduce the number of keystrokes, +1 or -1 can be entered just by pressing “+” or “-“ before performing the operation.



Valhall key



Valhall key



The Valhall key is a modifier key (along with Shift and All keys on the Image panel) that provides additional functionality when used together with other keys. The Valhall key is either pressed and released before selecting the second key or held wild pressing the second key.



Programmable Media Transport controls Under the tab Media keys in the User Profile, you can select how the media transport controls will behave. The Valhall key provides a second set of programmable transport controls.



Edit Controls The Edit controls are used to set in- and out-points, perform editing and more. Cue Cues up the machine to a specified timecode. Just pressing the key will cue up the machine to the event in focus. You can also enter a timecode from the numeric keyboard (see Entering Timecode from Keyboard) and press Cue.
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Search Dial To support the normal jog and shuttle operation of a VTR (or another machine), there is a Search dial mounted in the panel. To toggle jog and shuttle mode, push the dial or press the Jog key. Acceleration levels can be set separately for Jog and Shuttle in the VTR menu of the User Profile. Tip! Changing jog/shuttle mode by pushing the dial can be inhibited by enabling the control “Disable change of Jog/Shuttle from dial” under the VTR tab in the User Profile.
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27. Colour Panel



About the Colour Panel



The Colour control panel is dedicated for Colour Grading with programmable function keys within easy reach from the large and comfortable trackballs.
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Controls Display



Key Area setup A/Main



Bypass



1



Clear



2



Area



3



A



B



Page selection



B/Key



Programmable Function keys



Ring



Trackball



Keys Some keys have a built-in LED that shows the status. The brightness can be set in the User Profile window under the Panels page.



Knobs Each knob has a built in push-button switch, which is mostly used for clearing the parameter corresponding to the knob. To clear, the knob has to be held down for a longer period of time (determined by the user preferences). It is actually when the user releases the knob that the clear takes place.
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Trackballs When controlling the RGB controls of the primary from a trackball, the ball itself (or rather the backlight LED’s) will change colour accordingly if enabled in the User Preferences window. The outer ring surrounding the ball affects the luminance (Y), while the ball changes RGB values. A function clear/centre an RGB value and/or Y can be programmed on the function keys of the Colour panel. Tip! Each processing window provides an acceleration setting for the controls used (trackball, rings or knobs).



Tip! Trackball backlight can be disabled under Panels in the User Profile dialogue.



Programmable function keys The Colour panel provides a large number of programmable function keys within easy reach from the trackballs. They can be programmed individually for each user to perform various operations including memories, machine and list control. The function keys are defined in the User Profile window under Colour Keys. Tip! To preview the programmed functions without executing them, keep the Valhall key on the Image panel pressed while accessing the function keys. The programmed functions will be displayed on the Colour panel display. Tip! If you want to have quick-notes on the Colour panel that do not change as other Quick-notes depending on the selected option, there are dedicated Colour Correction Quick-notes for this purpose. These programmable functions are found in the DVNR ACP group and are called Mem 1-6.



Display As there is no panel-print for the different functions/parameter accessible from the knobs and buttons, labels and values are shown on the display. Activated functions will be shown as a box with the text inverted The user can change the brightness of the display in the User Profile dialogue.
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Appendix A: Panel Keyboard Reference



The following list describes all operations that can be performed from the control panels. -x



Press and Hold



#



Unsigned Numerical entry



±#



Signed Numerical entry (offset)



TC



Unsigned Timecode entry



±TC



Signed (offset) Timecode entry



Key-X means that the key is kept pressed for an extended duration (press and hold), either to give the key two functions or to prevent accidental activation. # + key means numerical input made with the keypad on the Media panel prior to pressing the function key. Key1 + Key2 means that Key1 is pressed before Key2 alternatively Key1 is held while pressing Key2.
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Command



Function



All



A Key used in combination with other keys to group elements



Shift



A Shift Key used in combination with other keys to provide extended functionality



Valhall



An Alt Key used in combination with other keys to provide alternate functions



List



Open Primary List window and assign certain keys for List operations



List-x



Close Primary List window



Valhall+List



Open Secondary List window



Valhall+List-x



Close Secondary List window



Note



Open Note window and assign certain keys for Note operations



Note-x



Close Note window and return to List mode
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Command



Function



Valhall+Note



Switch between Note sets



#+Note



Recall Note no.



#+Note-x



Save Note no.



Still



N/A



Select



Select current event



Select-x



Unselect current event



All+Select



Select all events



All+Select-x



Unselect all events



Shift+Up/Down



Select range of events (with arrow up/down)



Delete



List: Delete selected event(s) Note: Delete selected note Bookmark: Delete selected bookmark



All+Delete



List: Delete all events Note: Delete all notes Bookmark: Delete all bookmarks



Clear



List: Clear selected event(s) from settings Note: N/A Bookmark: N/A



Up



List: Go one event back Note: Go back one note Bookmark: Go back one bookmark



Valhall+Up



List: Go one event back and recall settings Note: Go back one note and recall settings Bookmark: N/A



Down



List: Go one event forward Note: Go forward one note Bookmark: Go forward one bookmark



Valhall+Down



List: Go one event forward and recall settings Note: Go forward one note and recall settings Bookmark: N/A



Enter



List: Set selected event(s) if changed Note: Save settings at selected note Bookmark: N/A



All+Enter



List: Program all settings at selected event(s) Note: N/A Bookmark: N/A



Enter-x



Update thumbnail at the current event



Recall



List: Recall settings from current event (except those locked) Note: Recall settings from selected note Bookmark: Cue to selected bookmark



All+Recall



List: Recall all settings from current event Note: N/A Bookmark: N/A



#+Recall



List: Recall settings from event no. Note: Recall settings from note no. Bookmark: N/A



User's Manual



User’s Manual



Command



Function



±#+Recall



List: Recall settings from current event +/- entered offset Note: Recall settings from current note +/- entered offset Bookmark: N/A



Mark



Create an empty event at current timecode



Mark-x



Create an event at current timecode and store settings



TC+Mark



Create an empty event at entered timecode



TC+Mark-x



Create an event at entered timecode and store settings



±TC+Mark



Create an empty event at current timecode +/- entered offset



±TC+Mark-x



Create an event at current timecode +/- entered offset and store settings



Dyn



Set an dynamic transition between selected event and the earlier programmed event



Dyn-x



Remove dynamic transition that ends at selected event



±TC+Trim



Trim the timecode of selected event(s)



Undo



Undo last list entry



Valhall+Undo



Open the History list



Valhall+Undo-x



Close the History list



Redo



Redo last undone entry



Save



Save a copy of the list



BookM



Insert Bookmark at current timecode



Valhall+BookM



Open the Bookmark window and assign certain keys for Bookmark operations



Valhall+BookM-x



Close the Bookmark window and return to List mode



#+BookM



Go to Bookmark no.



±#+BookM



Go back or forward a no. of Bookmarks



Frame



Mark and Set an one-frame event



Valhall+Frame



Preview current frame



Event



Positions the list cursor at the event where the VTR/Disk is located



#+Event



Positions the list cursor at entered event no.



#+Event-x



Cue up to entered event no.



±#+Event



Positions the list cursor at current event +/- entered offset



±#+Event-x



Cue up to the position of the list cursor +/- entered offset



Valhall+Event



Preview current event



Byp All



Toggle Bypass for all processing



Byp All-x



Force Bypass all off



Lock



Locks selected option in the list



All+Lock



Locks all options



All+Lock-x



Unlocks all options
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Command



Function



Single



Locks everything but the selected option in the list



Hold



Holds the selected option in the list



Hold-x



Forces Hold off on the selected option



All+Hold



Holds all option in the list



All+Hold-x



Removes hold from all options



Cue



List: Cue up to selected event Bookmark: Cue up to selected bookmark



TC+Cue



Cue up to entered timecode



±TC+Cue



Cue up to +/- entered timecode offset



TC+Play



Cue forward to unsigned timecode offset



TC+PlayRev



Cue backward to unsigned timecode offset



Asmbl



Select Assemble editing mode



Edit-x



Start autoedit



Valhall+Edit



Open the Edit dialogue



Valhall+Edit-x



Close the Edit dialogue



Rec-x



Craschrecording



Preview



Preview entered edits



Review



Review previous edits on the recorder



In



Set in-point at current machine position



In-x



Clear in-point



TC+In



Set in-point at entered timecode



Valhall+In-x



Set reference point of the selected machine at current machine position (ganging)



Valhall+In-x



Clear reference point of the selected machine (ganging)



TC+Valhall+In



Set reference point of the selected machine at entered timecode (ganging)



Out



Set out-point at current machine position



Out-x



Clear out-point



TC+Out



Set out-point at entered timecode



Orig



N/A



Prev



N/A



1–3



Page selection



1 – 3-x



Close all windows related to the page selection



Valhall+1 – 3



Bypass processing related to the page selection



Shift+1 – 3



Clear processing settings related to the page selection



F1 – F4



Programmable Function keys



M1 – M4



Programmable Function keys
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Command



Function



Wipe wheel



List: Browse Timeline or Event List Note: Bookmark:



Wipe key left



List: Zoom in Note: N/A Bookmark: N/A



Wipe key right



List: Zoom out Note: N/A Bookmark: N/A



Panel display commands 1–3



Page selection



A



Selects control of Main area



Area



Key area setup



B



Selects control of Key area



Bypass



Bypass of selected processing option



Clear



Clears shown settings for selected processing option



Clear-x



Clears all settings for selected processing option



Bookmark Command Reference The following list describes all Bookmark operations that can be performed from the control panels. The checkmark ( ) indicates commands that only are available in Bookmark mode. All other commands can be used at all times. Bookmark mode only
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Command



Function



Valhall+BookM



Open the Bookmark window and assign certain keys for Bookmark operations



Valhall+BookM-x



Close the Bookmark window



BookM



Insert Bookmark at current timecode and assign certain keys for Bookmark operations



#+BookM



Go to Bookmark no.



±#+BookM



Go back or forward a no. of Bookmarks



Delete



Delete selected bookmark



All+Delete



Delete all bookmarks



Enter-x



Update thumbnail at the current event



Recall



Cue to selected bookmark



Up



Go back one bookmark



Down



Go forward one bookmark



Wipe wheel



Browse through bookmarks
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Command



Function



Wipe key left



Go to first bookmark



Wipe key right



Go to last bookmark



Note Command Reference The following list describes all Note operations that can be performed from the control panels. The checkmark ( ) indicates commands that only are available in Note mode. All other commands can be used at all times. Note mode Command only



134 •



Function



Note



Open Note window and assign certain keys for Note operations



Note-x



Close Note window and return to List mode



Valhall+Note



Switch between Note sets



#+Note



Recall Note no.



#+Note-x



Save Note no.



Delete



Delete selected note



All+Delete



Delete all notes



Enter



Save settings at selected note



Recall



Recall settings from selected note



#+Recall



Recall settings from note no.



±#+Recall



Recall settings from current note +/- entered offset



Up



Go back one note



Valhall+Up



Go back one note and recall settings



Down



Go forward one note



Valhall+Down



Go forward one note and recall settings



Wipe wheel



Browse through notes



Wipe key left



Go to first note



Wipe key right



Go to last note
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Appendix B: Programmable Functions



The following list contains explanations functions that can be mapped to the function keys on the control panels, which are not selfexplanatory or otherwise explained in the manual.
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Group



Command



Function



DVNR ACP



Load Mem 1-6 Save Mem 1-6



Colour Correction Quick-notes that do not change as other Quick-notes depending on the selected option



List



Bypass List



“Bypasses” the whole list and does not affect any “Hold” when disabled



Copy -2



Copy the parameters two events back and paste into current. Useful for A/B shots



Replay



Positions the source machine a couple of seconds before the start of the event and goes into Play
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Index



A



C



AAC, 103 AC, 101 Access rights, 31 ACP, 26, 89 Additive luminance, 95 Additive saturation, 95 Administrator, 31 password, 31 AGR-IV, 61 area isolation, 64 ALS, 55 Analyzer, 94 Anamorphic, 36 Anti-alias, 108 Aperture corrector, 101, 103 ASC, 46, 48 ASC-II, 67 ASC-II+, 74 Aspect ratio, 108, 109 Assemble mode, 28 Autosave, 8, 34 Autoshot, 14, 34 filter, 34 sound, 43 trim, 114 Autotrack, 84



CD, 99 Chroma clip, 47, 50 Chroma delay, 48, 52 Chroma trim, 64 Clip, 47, 50 CMX, 21 Colour desaturation, 99 Comment, 12, 18, 26 Contrast, 82 Copy -2, 135 Coring, 106 Coverage, 83 CSR, 81 area isolation, 83 autotrack, 84 Cue, 9 Cue up, 123



B Backlight, 127 Baudrate, 113 Black clip, 47, 50 Blanking custom, 112 horizontal, 112 lower, 112 upper, 112 Bookmark, 6, 23 delete, 24 window, 23 BWF, 57 area isolation, 58 Bypass, 53 Bypass All, 53 Bypass list, 135
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D Desaturation, 100 DIS, 107 Display, 119, 122 brightness, 39 DVNR, 1, 113 setup, 5, 8, 45 DVNR1000, 3 DVNR1000-422, 46 DVNR1000-HD, 48 DVNR500, 3 Dynamic, 18



E Edge detection, 106 Edit delay, 115 Editing, 6, 27 EDL, 14 import, 14 EDL-list, 21 emulsion damages, 67, 74 Event indicator, 13 insert, 16 number, 12 Event list, 6, 11, 16 Eye-dropper, 94, 120
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F



M



Field correlator, 55, 58 Field dominance, 12, 46, 48 Field rate, 46, 49 Film, 46, 48 Find, 18 Format preset, 109 Frame key, 16 Frame Store Synchroniser, 49 Freeze, 66 Function keys, 120, 127



Mark, 16 Master, 115 Master hue, 91 Master Lift, 91 Master Saturation, 91 MDC, 75 Media, 46, 48 Modifier keys, 4, 41, 120 Monochrome, 47, 50, 111 MPEG mastering, 57 MPEG1, 55, 58



G Gain, 91 Gamma, 89, 91 Ganging, 28 Genlock, 47, 49 Global, 83 Grain size, 62 GUI, 33, 119



N Noise FM threshold, 67 Note comment, 26 Notes, 6, 25 Numerical keypad, 123



H



O



HAC, 102, 105 Help, 7 History, 20 Hold, 21 Hue, 91 HZOM, 107



Origin, 46 Output delay, 48, 52 Output format, 47



P



Jog, 37, 124 Jog Acceleration, 37



Page selection, 119 PAL-Plus, 107 Password, 31 Pattern, 111 Playspeed filter, 116 Premium+, 3, 4, 11 press and hold, 4 Press and hold, 39 Preview, 109 Processing Decision List, 9 Profile, 64 Project manager, 5, 8



K



Q



Key repeat rate, 39 Knob, 118, 126



Quick-notes, 26



I Input format, 47, 49 Insert, 111 Insert mode, 28 Internal oscillator, 49



J



L LED, 39, 118, 122, 126 Lift, 91 Limit, 47 List autosave, 8 layout, 12 save, 8 List cursor, 17 List layout, 35 List trim, 115 Lock, 21 Login, 5, 7 Login button, 8
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R Re-Blanking. See Blanking Recall, 12, 16 Redo, 19 Repeat rate, 39 RGB, 127 RGB Lift, 91 RGB limit, 47 RGB processing, 62



S Saturation, 91 Save, 8 Scratch detector, 82 Scratch width, 83 Search, 12



User's Manual



Search dial, 37, 124 Select, 17 all, 15 Set changes only, 34 Set on exit, 34 Shuttle, 37, 124 Shuttle acceleration, 37 Single, 20 Skin tone, 105 Soft, 101, 104 Sony EDL-format, 21 Sound, 43 Spatial filter, 63 Split, 71, 78, 85 Status bar, 5 Status Bar, 85 Syncro, 4 System setup, 5



T Test pattern, 111 Thumbnail, 36 aspect, 36 size, 36 update, 16 view, 35, 36 Timecode, 12 entry, 4 Timeline, 6, 13, 23 Toolbar, 5 Trackball, 120, 127 backlight, 39 Transition, 18 Transport controls, 41, 123 Trim, 19



U Undo, 19 Unselect, 17 User account, 8 window, 8 User management, 31 User profile, 33



V VAC, 102, 105 Valhall application, 7 colour, 4 image, 4 key, 40, 123 media, 4 Syncro, 4 Video, 46, 48 Video gain, 49, 92 Video viewer, 7 Viper, 64, 89, 90, 96 VTR, 15, 37, 113 VZOM, 107



W White clip, 47, 50 Wipe wheel, 119 Wobble, 83 Workspace, 5



Z Zoom, 109
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